


INTRODUCTION

INTRODUCTION

Thank you for purchasing NIC FAX.

This Operator’s Manual contains important information that you need to know in order to get the most out of the

powerful features and functions of NIC FAX. Be sure to read it carefully, and keep it on hand for future reference

when required.

Note that you are authorized to use this Operator’s Manual and the IC FAX applications only after you agree to the

terms and conditions of the User License Agreement (CD-ROM).

❐ This Operator’s Manual covers NIC FAX KIT TYPE140 on a Local Area Network (LAN).

❐ See the ICViewer Operator’s Manual for details on using the ICViewer.

❐ Installation of NIC FAX KIT TYPE140 should be performed by your sales or an authorized service provider. Do

not attempt installation on your own.

❐ The contents of this Operator’s Manual assume that you are already familiar with Windows functions and proce-

dures. If you are not, see the documentation that comes with Windows for details on how to use it.

❐ The manufacturer recommends the use of recycled paper. Contact your sales representative for details.

The contents of this Operator’s Manual assume that you are already familiar with Windows functions and

procedures. If you are not, see the documentation that comes with Windows for details on how to use it.

Important

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any

means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission.

Parts of this manual are subject to change without prior notice.

In no event will the company be liable for direct, indirect, special, incidental, or consequential damages as a result

of handling or operating the machine (hard ware and / or software) and the operator’s manual.

Trademarks

Microsoft®, Windows®, and MS-DOS® are registered trademarks of Microsoft Corporation in the United States and/

or other countries.

All brand names and product names mentioned in this manual are trademarks or registered trademarks of their

respective companies.

Other product names used herein are for identification purpose only and may be trademarks of their respective

companies. We disclaim any and all rights in those marks.
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A list of all the other buttons that appear within the text of this Operator’s Manual is shown below.

Click on a chapter title in the contents to jump directly to
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?

Click to jump to the referenced page.

Click for help on using this User’s Guide.
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Internet Fax Precautions

Note the following important precautions.

❐ NIC FAX does not support installation of the optional ISDN G4 Kit

(ISDN INTERFACE UNIT TYPE140 III), the optional G3 Kit (G3

INTERFACE UNIT TYPE140) and PC-FAX EXPANDER TYPE141.

❐ Internet Fax performs communication with a server over a LAN. It

cannot communicate directly with another party.

❐ Error Mails may not be able to be received. Confirm reception by

telephone when sending important mails.

❐ The level of security for Internet communications is low. The use of

standard subscriber lines is recommended for confidential commu-

nications.

❐ Voice communications are not supported over a LAN.

❐ Internet fax delivery might be delayed due to network congestion.

Use a standard fax whenever communication is time sensitive.

 Note

Functions Not Supported by Mail Transmission

❐ Immediate Transmission

❐ ID Transmission

❐ Confidential Transmission

❐ Polling Transmission

❐ Batch Transmission

❐ Forwarding of Substitute Reception or Confidential Reception

messages (Forwarding to a mail address not supported.)

❐ ECM

❐ To Print an OMR sheet (mail address input not supported)

❐ Dialling with the Dial Option Key

PRECAUTIONS

Note
The following functions are

supported with standard fax

transmission, but not with

Internet faxing.
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Functions Not Supported by Mail Reception

❐ Manual Reception

❐ ID Reception

❐ Forwarding Station (Forwarding of Mail not supported.)

❐ Confidential Reception

❐ Polling Reception

❐ Multi-sort Reception

❐ Authorized Reception

❐ Memory Lock

 NoteNote
Note that the sample operation

panel displays and IC FAX

application screens shown in

this Operator’s Manual may

differ somewhat from those that

actually appear.
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GETTING ACQUAINTED WITH NIC FAX

NIC FAX
FEATURES

Connecting NIC FAX to a LAN with Mail makes it possible to send

hard copy documents as mail to another NIC FAX or to a computer.

Documents received from a G3 fax can also be delivered or for-

warded as mail to a computer.

❐ TCP/IP communication protocols support connection to a LAN with Mail.

❐ Easy-to-master operations that are identical to those of a standard
fax machine.

❐ Also supports fax transmission and reception over a telephone line

❐ IC FAX Com Redirector can be used to send a fax from a compu-
ter on a LAN using a fax application.

❐ The IC FAX Monitor can be used to check the settings and status
of NIC FAX from a computer.

❐ ICViewer can be used to view, edit, and store images sent from
NIC FAX.

❐ Received faxes can be directly transferred or mailed to a computer.
Received fax data can be read at your own desk for improved
communication security.

❐ Use of the Internet greatly reduces communication costs.

❐ Elimination of the use of paper for fax transmission and reception
reduces paper expenses.

Server ServerPC

PC

PC

PC

design@abc.company.com

NIC FAX 2NIC FAX 1
E-Mail: nicfax2@abc.company.com

FAX No:212-1234-5678

E-Mail: nicfax1@abc.company.com

FAX No:310-8765-4321

London Branch of Company AParis Branch of Company A

Paris Branch of Customer B

Internet

Telephone 
Network

FAX No:213-5678-1234

G3FAX
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GETTING ACQUAINTED WITH NIC FAX

OPERATION
PANEL

This section describes the operation panel buttons and indicators that

are unique to NIC FAX. See the Operator’s Manual of the standard fax

for details on other operation panel buttons and indicators.

The following shows Quick Dial Key operations while the Mail button indicator is lit.

Quick Dial Key [27/59] [28/60] [29/61] [30/62] [31/63] [32/64]

Function @ • — – Symbol Shift

Mail

Press this key before inputting

the characters for a mail ad-

dress (see table below) with

the Quick Dial keys. The indi-

cator next to this button is lit

when mail address input is ac-

tivated for the Quick Dial keys.

F4 F5

01 02 03 04 05 06 07 08

09 10 11 12 13 14 15 16

17 18 19 20 21 22 23 24

25 26 27 28 29 30 31 32

A B C D E F G H

I J K L M N O P

Q R S T U V W X

Y Z

Pause/AI Redial

On Hook Dial

Clear

C

Memory

PC Printer
   Option

Halftone

Stamp

Check Display

Receive File

Auto Receive

F1 F2 F3

Space

Communi-
cating

Manual 
Receive

Speed Dial/
Tel Directory

ShiftSymbol

ShiftSymbol@ -_.

Mail
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GETTING ACQUAINTED WITH NIC FAX

NIC FAX converts fax (hard copy) document data transmitted over a

telephone line to mail format, and transmits the data over the Internet.

The mail sent by NIC FAX can be received by another NIC FAX or a

computer. Instead of inputting the telephone number of the destina-

tion you want to send to, you input the applicable mail address.

Documents are sent as mail messages with an attached TIFF-F or

DCX image. Because of this, a MIME-compatible mail reader is re-

quired in order to view documents received on a computer. To view an

attached image, software that is capable of displaying TIFF-F or DCX

formatted images is required. IC FAX applications include ICViewer,

which can be used to view, edit, and store image data. (See the

ICViewer Reference for full details on how to use it.)

NIC FAX must be connected to an LAN and set up correctly in order

to use its Internet fax functions. See "GETTING READY" of this Op-

erator’s Manual for details on connecting to a LAN and making initial

settings.

 Note

WHAT IS AN
INTERNET FAX?

Note
NIC FAX Internet fax functions

support mail communication

only. They do not support real-

time communication. Server ServerPC

PC

PC

PC

design@abc.company.com

NIC FAX 2NIC FAX 1
E-Mail: nicfax2@abc.company.com

FAX No:212-1234-5678

E-Mail: nicfax1@abc.company.com

FAX No:310-8765-4321

London Branch of Company AParis Branch of Company A

Internet

Telephone 
Network
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GETTING ACQUAINTED WITH NIC FAX

NIC FAX supports standard fax transmission to another fax machine,

as well as fax transmission from a computer on the LAN through NIC

FAX. A fax can be sent from the computer using a fax application.

 Note

Sending a Fax as Mail from NIC FAX

For Internet Fax, input the mail address instead of the fax number.

Make sure that the Memory

indicator is lit.

❐ If the Memory indicator is not lit, press the Memory key to

turn it on.

❐ The data for Internet fax transmissions must first be stored

into memory before it is sent. Immediate transmission is not

supported.

Place your document face

down into the feeder, and set

the scanning parameters.

❐ Messages are always sent as A4 size. If you feed wider docu-

ment than A4, it will be reduced in size to A4.

❐ Text is sent as Detail resolution (200 × 200 dpi), even if Fine

(200 × 400 dpi) is selected.

 Press Mail.

❐ Make sure that the Mail indicator is lit.

❐ Pressing Mail while a document is not set on the feeder

causes an error tone to sound.

BASIC TRANS-
MISSION

Note
• Because mail does not handle

extremely large messages well,

you may not be able to send

very long faxes as mail.

• The level of security for Internet

communications is very low.

The use of standard subscriber

lines is recommended for

confidential communications.

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

MEMORY TRANS.      OPTIONS  ↓

ENTER FAX NUMBER

           <G3>

MEMORY TRANS.      OPTIONS ↓

ENTER Mail ADDRESS       abc

           <Mail>
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GETTING ACQUAINTED WITH NIC FAX

Use the Quick Dial keys and

Ten-Key Pad to input the mail

address you want to send to.

❐ Letters and symbols will not be input if you press the Quick

Dial keys while the Mail indicator is not lit.

❐ As with the telephone numbers you input for standard faxes,

you can also use Quick Dial, Speed Dial, or Group Dial to

input mail addresses (do not press the Mail key in this case).

❐ Steps 3 and 4 are not necessary if you input the mail address

using Quick Dial, Speed Dial, or Group Dial.

❐ (@), period, underline, and hyphen can be input with the

Quick Dial keys after pressing Symbol. Use Shift to shift

between upper-case and lower-case characters.

Press Yes.

❐ This confirms the mail address as shown on the display and

causes the Mail indicator to go out.

❐ Repeat steps 3 through 5 if you want to input more.

MEMORY  TRANS.     OPTIONS ↓ 

PRESS YES OR CLR • NO

 nicfax1@abc.company.com

MEMORY  TRANS.     OPTIONS ↓ 

ENTER NO. OR START DEST:  2

            <G3>
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GETTING ACQUAINTED WITH NIC FAX

Note
• To cancel an Internet Fax, press

the Function key, followed by

the 2 and 1 keys.

• To cancel transmission, press

the Stop key.

STORING            MEMORY  98%

         PAGE 1

         FILE NO.3116

MEMORY TRANS. nicfax@abc.company.com

SET DOC. OR ENTER FAX NO.

                  MEMORY98%

Press Start.

❐ This starts reading of the document into memory. The mail

send operation starts after the read operation is complete. The

Communicating indicator is lit while a send operation is in

progress.

❐ With a long message, it may take some time before the trans-

mission starts. This is due to the time the machine requires to

convert the data in memory.

 Note
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GETTING ACQUAINTED WITH NIC FAX

Sending a Fax from a Computer

You can use IC FAX Com Redirector (see page 156~164) and a fax

application to send a fax from a computer without connecting a mo-

dem to the computer.

 Note

1 IC FAX Com Redirector, IC FAX Port, and a Type A03 fax modem

are installed on the computer at the London Branch of Company A.

The fax number (213-5678-1234) of the Paris Branch of Customer

B is dialled from the computer’s fax application.

2 NIC FAX at Company A sends the fax to the number that is dialled.

The fax number can be dialled manually, or by using Quick Dial,

Speed Dial, or Group Dial. See the following examples.

Note
Use Microsoft FAX or some

other fax application that

supports Class 2 AT commands

to send faxes from a computer.

Contact your sales or your

service representative for

information about computer fax

applications that are supported

by NIC FAX.

Paris Branch of Customer B 

NIC FAX

Telephone 
Network

FAX No:213-5678-1234

G3FAX

London Branch of Company A

E-Mail: nicfax2@abc.company.com

FAX No:212-1234-5678

PC Server

PC
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GETTING ACQUAINTED WITH NIC FAX

Dialling Method Format Example

Quick Dial # (two-digit Quick Dial number) #12

Speed Dial # *  (two-digit Speed Dial number) # * 23

Group Dial # * *  (two-digit Group number) # * * 05

If a Quick Dial, Speed Dial, or Group Dial number is assigned a mail

address, mail is sent to the applicable address when the number is

dialled.

Note that you can input Quick Dial, Speed Dial, and Group Dial num-

bers in series for broadcasting of the same message to multiple

destinations.

Example: #12# *  23# * *  05

 NoteNote
• Be sure to input a leading zero

to change one-digit numbers

into two-digit numbers. For

example, input 5 as 05.

• When an optional FUNCTION

UPGRADE CARD TYPE140 is

installed, you must input three

digits for Speed dial. This means

you must input two leading

zeros to change one-digit

numbers into three-digit num-

bers.
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GETTING ACQUAINTED WITH NIC FAX

RECEPTION
FUNCTIONS

Routing of a Received Document to a Computer

Four-digit numeric Personal Codes (pages 111, 142) and routing

addresses (mail addresses) for each Personal Code can be registered

in NIC FAX. Then when a fax with a SUB appended as a dial option is

received from a fax machine with Personal Code send capabilities, NIC

FAX automatically delivers the fax as mail to an address programmed

in a Quick Dial or Speed Dial.

 Note 1
To use this function, the sender must be informed of the proper Per-

sonal Code (four-digit ID number registered as the receiver’s Personal

Code) to use.

1 Paris Branch of Customer B sends a fax from a G3 machine to the

London Branch of Company A with Personal Code 1111 ap-

pended.

2 NIC FAX in London Branch of Company A receives the fax and

delivers it as mail to the computer specified by the Personal Code.

 Note 2

Note 1
• A single mail address only can

be registered for each Personal

Code.

• NIC FAX can be set up to print a

forwarding mark on faxes that

are delivered as mail. See page

224 of the main Operator’s

Manual for details on turning the

forwarding mark on and off.

Forwarding mark printing is

turned on as the initial factory

default.

Paris Branch of Customer B

Server

PC

design@abc.company.com

1111=design@abc.company.com

212-1234-5678+1111

Personal Code:1111

NIC FAX

FAX No:213-5678-1234

G3FAX

PC

Telephone 
Network

E-Mail: nicfax2@abc.company.com

FAX No:212-1234-5678

London Branch of Company A

Note 2
• RTI (Receive Terminal Identifi-

cation) or CSI (Called Station

Identification) is shown on the

computer as the subject of the

mail message.
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Forwarding of a Received Document to a Computer

Unlike document delivery which requires Personal Code registration

and appending of an ID number (Personal Code and SUB) by the

sender, a received document is forwarded to a computer in accord-

ance with its RTI (Receive Terminal Identification) or CSI (Called

Station Identification). With this method, the sending fax does not

need to have function code send capabilities.

Use of this function requires Forwarding Station Address to which

memory contents are to be forwarded.

1 Paris Branch of Customer B sends a fax to the London Branch of

Company A.

2 The fax is received on NIC FAX at Company A, and forwarded to

the personal computer whose mail address is specified to receive

faxes from RTI: Customer B.

 Note

Paris Branch of Customer B

Server

PC

design@abc.company.com

COMPANY B=design@abc.company.com

FAX No:213-5678-1234

G3FAX

RTI:COMPANY B

PC

RTI:COMPANY B

London Branch of Company A

Telephone 
Network

NIC FAX E-Mail: nicfax2@abc.company.com

FAX No:212-1234-5678

Note
• See page 145 of this Operator's

Manual and page 108 of the

main Operator’s Manual for

details on Forwarding Station

Address.

"Forwarding Station Address"

........................ See to p.145 

• RTI (Receive Terminal Identifi-

cation) or CSI (Called Station

Identification) is shown as the

subject of the forwarded mail

message.
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IC FAX Applications

NIC FAX comes with IC FAX applications that can be installed on your

computer. IC FAX applications include the following software.

❐ IC FAX Monitor

❐ IC FAX Com Redirector

❐ ICViewer

 Note

IC FAX Monitor

This utility software lets you configure NIC FAX to suit your individual

needs, and check its current status on your computer’s display. The

following items can be set or checked using IC FAX Monitor.

❐ Setup (page 56)

❐ Setting the Administrator Mode Password (page 62)

❐ Back up (page 63)

❐ Restore (page 64)

❐ Memory Status (Transmission, Reception, Auto Document) (page

123)

❐ Display Journal (Transmission, Reception) (page 128)

❐ Address Book (Quick Dial, Speed Dial, Group Dial) (page 129)

❐ Multi-step Transfer Group (page 139)

❐ Personal Codes (page 142)

❐ Forward Station Addresses (page 145)

Note
• See page 29 for the system

requirements for running the IC

FAX applications.

"System Requirements"

.......................... See to p.29 
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IC FAX Monitor has a User Mode and an Administrator Mode  (page 54).

The User Mode can be used to check settings but not change them.

Administrator Mode access requires input of a password. The Admin-

istrator Mode can be used to change settings and perform all func-

tions available with IC FAX Monitor.

IC FAX Com Redirector

This software can be used to send a request to NIC FAX to transmit a

fax from PC FAX  application.

Normally, data from the computer’s COM port is sent over the LAN to NIC

FAX, which then transmits the fax. IC FAX Com Redirector makes it possi-

ble to send a fax directly from a computer without connecting a modem.

 Note

Note
• Use Microsoft FAX or some

other fax application that

supports Class 2 AT commands

to send faxes from a computer.

Contact your sales or your

service representative for

information about PC FAX

applications that are supported

by NIC FAX.

• You must also have IC FAX Port

and Facsimile Modem Type A03

installed on your computer in

order to use IC FAX Com

Redirector.
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ICViewer

With this software, you can view, edit, and store images  (TIFF-F and

DCX files) sent from NIC FAX by mail.

See the separate ICViewer Operator’s Manual for details on how to

use it.

 Note

Note
• See the separate ICViewer

Operator’s Manual for details on

how to use it.
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CONNECTING TO
A LAN

Connecting the LAN Cable

The following steps must be performed before you can use NIC FAX.

1.  Connection of NIC FAX to a LAN.

❐ Connection requires a LAN cable. (10Base-T)

2.  Mail server settings (by network administrator)

3.  Initial settings (IP address, subnet mask, default gateway settings)

4.  Installation

❐ Installation of the IC FAX applications on your computer

5.  IC FAX Monitor settings

Since NIC FAX communicates over a LAN using TCP/IP protocols, it

requires a 10BASE-T LAN cable for connection.

 Note

Plug one end of the cable into the NIC FAX port. Note that

the tab of the plug should be facing to the right of NIC FAX

when viewed from the rear.

Plug the other end of the cable into a hub.

 10BASE-T cable

Hub(Back of NIC FAX)

Note
• 10BASE-T cable is not supplied

with NIC FAX.
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The information in this section is for your network administrator.

NIC FAX uses an Internet mail system to send Internet faxes. Since it

automatically connects to the mail server to get mail, a NIC FAX

account and password must be set up on the mail server. See the

documentation for the mail server for details on the procedure re-

quired for setting up accounts and passwords.

Be sure to provide the NIC FAX IP address and host name informa-

tion to NIC FAX users, who need to input them when establishing a

connection with IC FAX Monitor and IC FAX Com Redirector.

Mail Servers That Have Been Confirmed To Work

• Sendmail/QUALCOM Pop server

Program SMTP sendmail Ver.8 or higher

POP QUALCOM Pop server

OS Solaris 1 Ver.2.1.4-R3

• Post Office

Agency Software.com

Ver.3.1 Release PO203a

• Seattle Lab Mail Server

Agency Seattle Lab Inc

Ver.2.4

• Netscape Messaging Server

Agency NetScape Communications

Ver.3.0

• IMail Server for Windows NT

Agency Ipswitch, Inc.

Ver.4.0

 Note

MAIL SERVER
SETTING
(BY NETWORK
ADMINISTRATOR)

Note
• Supported operations and

services differ according to the

mail server used.
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INITIAL SETTINGS

Note
• Please consult your network

administrator to obtain the IP

address, subnet mask, and

default gateway settings.

The procedure described here should be performed after NIC FAX is

connected to the LAN and the required mail server settings are com-

plete. The following describes the three initial settings:

❐ IP address

The IP address is assigned to NIC FAX by your network adminis-

trator. An IP address is made up of four numbers, each of which is

in the range off 0 to 255, separated by periods.

❐ Subnet mask

The subnet mask is assigned by your network administrator.

❐ Default gateway

This is the address of the gateway (router) to which NIC FAX is

connected. The default gateway setting is required when connect-

ing to another network.

Making Initial Settings

 Note

Press Function 6 0.

Press 222261.

Press ∞ until the IP address

appears on the display.

Press Yes.

SYSTEM SET

NO TO CANCEL
-

61INITIAL SET 62FUNCTION SET

63U. PARAMETER 71PERS. CODE ↓

-
SYSTEM SET NO.:     OR  NO 

OWN NUMBER <G3>

 YES TO SET         PREVIOUS ↑

 NO  TO CANCEL          NEXT ↓ 

IP ADDRESS

 YES TO SET         PREVIOUS ↑

 No  TO CANCEL          NEXT ↓
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Input the IP address.

❐ If a number has only one or two digits, input it and then press

2 to move the cursor to the next number.

❐ Pressing Clear deletes the digit at the current cursor position.

❐ Pressing No clears the entire IP address.

Press Yes.

Press Yes.

❐ This displays the subnet mask setting screen. If you want to

exit the initial setting procedure at this point, press Function.

Input the subnet mask.

❐ If a number has only one or two digits, input it and then press

3 to move the cursor to the next number.

Press Yes.

IP ADDRESS

                   YES TO END 

         .    .    . 
-

IP ADDRESS

 YES OR CLR • NO            →

-
 192.168. 15. 16  

SUBNET MASK

 YES TO SET         PREVIOUS ↑

 NO  TO CANCEL          NEXT ↓

SUBNET MASK

                   YES TO END

-
     .   .   .  

SUBNET MASK

 YES OR CLR • NO            →

-
  255.255.255.  0

DEFAULT GATEWAY

 YES TO SET         PREVIOUS ↑

 NO  TO CANCEL          NEXT ↓
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DEFAULT GATEWAY

         .    .    . 
-

                   YES TO END
Press Yes.

❐ This displays the default gateway setting screen. If you want to

exit the initial setting procedure at this point, press Function.

Input the default gateway.

❐ If a number has only one or two digits, input it and then press

3 to move the cursor to the next number.

Press Yes.

Press Function.

DEFAULT GATEWAY

 YES OR CLR • NO            →

-
       192.163.15.  1

SYSTEM SET 

61INITIAL SET 62FUNCTION SET

63U. PARAMETER 71PERS. CODE

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%
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INSTALLATION System Requirements

The following is the required system for a computer running the IC

FAX applications.

Computer : IBM PC/AT or compatible running Windows 95

(English)

CPU : i486DX-100MHz or higher

Minimum Memory : 16MB minimum

Free Disk Space : 30MB minimum

Operating System : Windows 95 (English)

Display : SVGA 640 × 480, 256 colours minimum

Network : LAN connection, TCP/IP protocols

 Note

Before Starting Installation

Running the installation program on the CD-ROM that contains the IC

FAX applications causes the three programs listed below to be in-

stalled by default. Note, however, that you can also specify installation

of specific programs if you want.

❐ IC FAX Com Redirector

❐ IC FAX Monitor

❐ ICViewer

Note
• Operation cannot be guaranteed

for all system configurations.
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Installing the IC FAX Applications

Turn on the computer and start up Windows 95.

 Note

Insert the CD-ROM that contains the IC FAX applications

into the computer’s CD drive.

On the [Start] menu, select [Run].

This causes the [Run] dialog box to appear.

Type the text shown below into the Text Box and then click

[OK].

Type: D:\IcFaxApplication\ENGLISH.UK\Setup. exe

CD-ROM drive name. Use the actual name of the

CD-ROM drive on your system.

❐ Clicking [OK] above prepares the Install Shield wizard. When

the progress bar reaches 100%, the Question dialog box will

appear.

Note
• Close all files, exit all applica-

tions, and restart Windows 95

before installing the IC FAX

applications.

[OK]

Text Box

Progress Bar
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Click [Yes] in response to the dialog box that appears to

start installation.

❐ To check whether other applications are running, hold down

[Alt] and press [Tab]. Exit all other applications that are run-

ning before you click [Yes].

❐ The dialog shown below appears if IC FAX Com Redirector is

running. Note that IC FAX Com Redirector is not shown in the

box that appears when you press [Alt] + [Tab]. In this case, you

have to click [No]  to exit the installation, Quitting IC FAX Com

Redirector (page 159), and then restart installation from step 1.

[Yes]
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After checking the contents of the dialog box, click [Next].

After viewing the information, click [Next].

 Note

[Next]

Note
• The information dialog box

contains important information

you need to know about instal-

lation. Be sure to read it all

carefully. Use the scroll buttons

to scroll the information up and

down.
[Next]

Scroll Button

Scroll Button
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Type in your name and the name of your company, and then

click [Next].

Select [Typical] and then click [Next].

 Note

Note
• If you want to change the

location where the IC FAX

applications will be installed,

click [Browse] to display a

dialog box for specification of a

directory. After you specify the

directory, click [Next].

[Next]

Your name
and the
name of your
company

[Next]

[Typical]
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Using the Customize Option

Step 9 above automatically installs all three of the programs that make

up the IC FAX applications. Substitute the following two steps for step

9 when you want to install one or two of the available programs.

 (1) Select to [Custom] and then click [Next].

  (2) Put checks in the checkboxes next to the program names in

the component list box to select the programs you want to

install.

[Next]

[Custom]

[Next]

Component
List Box
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 Click [Next].

❐ To change to another folder, click on the folder name in the list

and then click [Next].

 Note
❐ A dialog box appears on the display showing you the progress

of the installation as it is performed.

❐ A message appears on the display to let you know when

installation is complete.

Note
• Use of only the folders shown in

the list is recommended.

[Next]
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 (1) To assign IC FAX Port, put a check in the checkbox next to

[Install IC FAX Port by Hardware Wizard] and then click

[Finish].

 Note

When the Custom Option is Used not to Install IC FAX Com Redirector

 (2) In this case, the dialog box shown below appears after

installation is complete. Click [Finish].

❐ Put a check in the checkbox in the above dialog box before you

click [Finish] if you want to view the contents of the ReadMe file

before exiting the installation. After reading the contents of the

file, click the close box to close it and complete the installation.

Note
If you do not to use the Hard-

ware Wizard, use the following

procedure to install IC FAX

Port.

1. On the [Start] menu, point to

[Settings] and then click

[Control Panel].

2.Double-click the [Add New

Hardware] icon.

3.In the dialog box that appears,

click [Next].

4.Continue from step 13 of the

installation procedure.

Checkbox of
[Install IC FAX
Port by Hard-
ware Wizard]

[Finish]

[Finish]
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Click [Next].

Click the radio button next to [No]  so it is selected, and then

click [Next].

[Next]

[Next]

[No]
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Click on [Ports (COM & LPT)], and then click [Next].

 Note

Click [Have Disk].

Note
• If you can’t see [Ports (COM &

LPT)] in the list box, use the

scroll buttons to scroll the list up

and down.

[Next]

Scroll Button

Scroll Button

[Ports
 (COM & LPT)]

[Have Disk]
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Type the text shown below into the text box and then click

[OK].

❐ Type:D:\IcFaxApplication\ENGLISH.UK

CD-ROM drive name. Use the actual name of the

CD-ROM drive on your system.

Click on [IC FAX Port] and then click [Next].

Text Box

[OK]

[Next]

[IC FAX Port]
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Click [Next].

 Note

Click [Finish] .

❐ Next install Facsimile Modem Type A03 for IC FAX Com

Redirector.

Note
• You can manually change the I/

O port address after installation

is complete. Note that a device

may fail to operate properly if

there is a conflict with another

device.

[Next]

[Finish]
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Click [No].

On the [Start] menu, point to [Settings] and then click [Con-

trol Panel].

In Control Panel, double-click the [Modems] icon.

❐ The Modems Properties window appears.

❐ If your computer has a modem currently installed, perform

step 23. Skip to step 25 if your computer does not have a

modem installed.

Click [Add].

[No]

[Add]
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Put a check in the checkbox to disable startup of Hardware

Wizard and then click [Next].

Put a check in the checkbox next to “Don’t detect my mo-

dem;...” checkbox to select it, and then click [Next].

[Next]

[Next]

[Don’t detect
my modem;
I will select
it from a list]



USING FUNCTIONS

IC FAX Com 
Redirector

TROUBLESHOOTING

APPENDIX

GLOSSARY

INTERNET FAXING

GETTING READY

GETTING AQUAINTED
WITH NIC FAX

IC FAX Monitor

Contents

Index

43

GETTING READY

Click [Have Disk...] .

Type the text shown below into the text box and then click

[OK].

❐ Type: D:\IcFaxApplication\ENGLISH.UK

CD-ROM drive name. Use the actual name of the

CD-ROM drive on your system.

[Have Disk...]

[OK]

Text Box
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Click on [Facsimile Modem Type A03] and then click [Next].

Click on [IC FAX Port (COM 3)] and then click [Next].

❐ IC FAX Port is normally installed for COM3. If COM3 is al-

ready in use, it is installed for COM4 or higher.

❐ 16-bit faxing applications are not supported if IC FAX Port is

installed for COM5 or higher. Use 32-bit PC Fax applications

for COM5 or higher settings.

[Next]

[Facsimile
Modem Type
A03]

[Next]

[IC FAX Port

(COM 3)]
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Click [Finish].

Click [OK].

[Finish]

[OK]

[Facsimile
Modem Type
A03]
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Remove the CD-ROM from the drive. On the [Start] menu

click [Shut Down], and then click [Restart the computer?].

❐ This restarts Windows 95 and displays the initial IC FAX Com

Redirector screen.

Type the IP address or host name into the [Connect] text

box, and if necessary, a four digit Personal Code into the

[Personal Code] text box, and then click [OK].

 Note

[OK]

[Connect]
[Personal Code]
IP Address Example: 192. 168. 15. 16
Personal Code Example: 0001

[Do Not Show This Dialog At Startup.]

Note
• Type in the Personal Code if

needed.

• If you put a check in the

checkbox next to [Do Not Show

This Dialog At Startup], this

dialog box will not appear from

the next time you start up

Windows 95, even if NIC FAX

is not connected. To display the

dialog box in this case, double-

click the [IC FAX Com

Redirector] icon located on the

Task Bar.
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UNINSTALLING
THE IC FAX
APPLICATIONS

Perform the following procedures to uninstall the IC FAX applications

from your computer.

 Note

Uninstalling the IC FAX Applications

Turn on your computer and start up Windows 95.

Quit all IC FAX applications. Use the procedure below to quit

IC FAX Com Redirector.

1 On the Task Bar, right click the IC FAX Com Redirector icon.

2 Choose [Exit].

3 In the dialog box that appears, click [OK].

❐ You cannot uninstall the IC FAX applications if any of them are

running. See page 119 of this Operator’s Manual for details on

quitting IC FAX Monitor, and the ICViewer Operator’s Manual

for quitting ICViewer. See page 159 of this Operator’s Manual

for full details on quitting IC FAX Com Redirector.

On the [Start] menu, point to [Settings] and then click [Con-

trol Panel].

Double-click the [Add/Remove Programs] icon.

Note
• If the folder where the IC FAX

applications were installed

contains an Address Book back

up file that was created by IC

FAX Monitor, the back up file is

not deleted by the uninstall

procedure.
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In the dialog box that appears, click on [IC FAX Application]

in the list box, and then click [Add/Remove].

[IC FAX
Application]

[Add/
Remove]
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Click [Yes].

❐ A dialog shows the progress of the uninstall procedure.

Click [OK].

Click [OK].

[Yes]

[OK]
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Uninstalling the IC FAX Port

Turn on your computer and start up Windows 95.

Use the procedure below to quit IC FAX Com Redirector.

1 On the Task Bar, right click the IC FAX Com Redirector icon.

2 Choose [Exit].

3 In the dialog box that appears, click [OK].

❐ You cannot uninstall IC FAX Port if IC FAX Com Redirector is

running. See page 159 of this Operator’s Manual for full

details on quitting IC FAX Com Redirector.

On the [Start] menu, point to [Settings] and then click

[Control Panel].

Double-click the [System] icon.

Double-click the [Device Manager] tab.

Click on the      next to [Ports (COM & LPT)].

[Port (COM & LPT)]
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Click on [IC FAX Port (COM 3)] and then click [Delete].

Click [OK].

[IC FAX Port
(COM 3)]

[Delete]

[OK]
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Click [Close].

[Close]
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[Facsimile
Modem
Type A03]

[Delete]

Uninstalling Facsimile Modem Type A03

Turn on your computer and start up Windows 95.

On the [Start] menu, point to [Settings] and then click [Con-

trol Panel].

Double-click the [Modems] icon to display the modem prop-

erties dialog box.

On the [General] tab, click on [Facsimile Modem Type A03]

and then click [Delete].
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IC FAX Monitor
SETTINGS

After completing mail server settings, initial settings, and installation,

you are ready to use IC FAX Monitor to make mail, TCP/IP and other

system settings.

 Note 1

Entering the Administrator Mode

Before making system settings you have to first perform the proce-

dure below to enter the Administrator Mode.

Click the [IC FAX Monitor] icon.

❐ You could also open the [Start] menu, point to [Programs], point

to [IC FAX Applications], and then click [IC FAX Monitor].

Type the IP address or host name into the [Host Name] text

box, and then click [OK].

The above shows input of the example IP address 192.168.15.16.

 Note 2

On the [Connect] Menu, click [Administrator Mode].

Note 1
• This section contains proce-

dures for making system

settings only. See page 116 of

this Operator’s Manual for full

details on using the IC FAX

Monitor.

"IC FAX Monitor"

....................... See to p.116 

Note 2
• In using the Administrator

Mode, functions 20 through 40

and the function with the

password of “2222” cannot be

used. While these functions are

used, the Administrator Mode

cannot be entered.

[IP Address] or
[Host Name]

[OK]
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[OK]

[Password]

The factory default password is a blank (null), so simply

click [OK] to enter the Administrator Mode the first time.

 NoteNote
• See “Setting the Administrator

Mode Password” on page 62 for

details on changing the Admin-

istrator Mode password.

"Setting the Administrator

Mode Password"

..........................See to p.62 

• Failure to perform any input for

10 minutes in the Administrator

Mode causes an error. Next, IC

FAX Monitor returns automati-

cally to the User Mode.
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Internet Mail Settings

In the Administrator Mode, execute the [Settings] menu’s [Setup]

command to display the [Setup] dialog box.

Click the [Mail] tab in the [Setup] dialog box.

[Mail]

1

[OK]

8

6

7

4

3

2

5
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Make the [Mail] settings described below (1 through 8), and

then click [OK].

1 [SMTP Server]

Type in the IP address of the SMTP server to be connected to

for sending Internet mail.

2 [POP Server]

Type in the IP address of the POP server to be connected to

for receiving Internet mail.

3 [Host Name]

Type in the NIC FAX host name. This input can be skipped.

4 [Mail Address]

Type in the NIC FAX mail address. The address you type here

is automatically added to the “From” field of outgoing mail.

5 [Domain Name]

Type in the domain name of the network where NIC FAX is

located. This input can be skipped.

6 [Login Name]

Type in the name for logging into the POP server.

7 [Login Password]

Type in the password for logging into the POP server.

8 Mail RX Interval

Specify the minimum interval for logging into the POP server

to pick up any mail that is waiting. An interval in the range of 1

to 60 minutes can be specified, in one-minute units. The

factory default setting for the interval is 3 (minutes).
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TCP/IP Settings

In the Administrator Mode, execute the [Settings] menu’s [Setup]

command to display the [Setup] dialog box.

Click the [TCP/IP] tab in the [Setup] dialog box.

1

[TCP/IP]

2

3

[OK]
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Make the [TCP/IP] settings described below (1 through 3),

and then click [OK] .

1 [IP Address] , [Subnet Mask] , [Gateway]

Make sure that these items are identical to those you input on

the NIC FAX control panel (page 26).

2 [Access Control]

Type in the IP address to which NIC FAX can connect when

using the PC FAX function. Leave this setting at 0.0.0.0 if you

don’t need to use it.

3 [Access Mask]

Type in an access mask to limit the range of IP addresses that

can connect to NIC FAX. Leave this setting at 0.0.0.0 if you

don’t need to use it.

Example:

Access Control : 192.168.15.16

Access Mask : 255.255.0.0

In this case, IP addresses that can connect to NIC FAX is:

192.168.xx.xx
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Other Settings

In the Administrator Mode, execute the [Settings] menu’s [Setup]

command to display the [Setup] dialog box.

Click the [Others] tab in the [Setup] dialog box.

1

2

3

4

5

[OK]

[Others]
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Make the settings described below (1 through 5), and then

click [OK].

1 [Admin. Mail Address]

When notification mail messages (error notifications, relay

result notifications) are generated by NIC FAX and sent to the

originator of a message, a copy of the notification is also sent

to the address you specify here. This input can be skipped.

2 [Backup Mail Address]

Copies of all mail sent from NIC FAX are also sent to this

address. This input can be skipped.

 ❐ Specifying a Backup Mail Address causes all mail to be sent

to the address. This means the backup address requires large

memory capacity.

 Note
3 [Print Header Information]

Put a check in this checkbox if you want header information to

be printed in received mail.

4 [Greenwich Mean Time Difference]

Specify the difference between Greenwich Mean Time and the

time zone you are currently located in. You can use the drop-

down list or click the button to get the value from Control

Panel.

Example

London GMT

Paris GMT + 01:00

5 [Image Format]

Select the image format to be used when attaching fax data

images to mail.

Note
• Do not specify the NIC FAX

mail address as the Admin. Mail

Address or Backup Mail Ad-

dress. Doing so can cause

operational problems when

transfer request mail is bcc’d to

NIC FAX.



USING FUNCTIONS

IC FAX Com 
Redirector

TROUBLESHOOTING

APPENDIX

GLOSSARY

INTERNET FAXING

GETTING READY

GETTING AQUAINTED
WITH NIC FAX

IC FAX Monitor

Contents

Index

62

GETTING READY

On the [Settings] menu, click [Password] to display the password

settings dialog box. Use this dialog box to specify a password that

controls access to the Administrator Mode.

In the dialog box, make the required password settings and

then click [OK].

1 [Current Password]

Type in the password you want to change from. If this is the

first time you are setting a password since installing IC FAX

Monitor, leave this text box blank.

2 [New Password]

Type in up to eight characters for the password to which you

want to change. Note that IC FAX Monitor distinguishes be-

tween upper-case and lower-case characters.

3 [Confirm New Password]

Retype the password you specified into the [New Password]

text box.

 ❐ Password settings you make go into effect when you click [OK].

  Note

SETTING THE AD-
MINISTRATOR
MODE PASSWORD

1

2

3

[OK]

Note
• Make sure you keep a separate

record of your password so you

do not forget it. If you do, you

will not be able to access the

Administrator Mode.

• Should you forget the password,

contact your service representa-

tive.
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BACKING UP
AND RESTOR-
ING MEMORY
DATA

Backing Up Memory Data

Making a backup file of memory data provides an easy way to restore

normal operation should data be accidentally corrupted or deleted.

The following is a list of data that is backed up by the procedure

described below.

❐ Quick Dial

❐ Speed Dial

❐ Group Dial (including Multi-step Transfer Groups)

❐ Personal Codes

❐ Forwarding Stations

In the Administrator Mode, execute the [Settings] menu’s

[Service Tools] command followed by  [Backup] command to

open the backup dialog box.

After confirming the name of the backup file, click [OK] to

save the data.

 NoteNote
• You cannot open a backup file

on your computer.

[Browse]

[OK]
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To save the data in a different file

You can leave the default backup file name as it is or change

it by clicking the [Browse] button, which opens a standard

Windows file name specification dialog box.

Click [OK] to save the data.

Restoring Memory Data

Use the procedure below to import data from a backup file and re-

store NIC FAX to the settings based on the backup file data.

Before you perform the restore operation, you must first ensure that

all Quick Dial, Speed Dial, Group Dial, Personal Codes, and Forward-

ing Station data has been cleared from IC FAX memory. You can

check if any of this data is in memory by printing reports.

 Note

In the Administrator Mode, execute the [Settings] menu’s

[Restore] command to open the restore dialog box.

[Save]

Note
• Restore is intended for use to

recover from a hardware mal-

function. Restoring data for any

other reason can cause commu-

nication problems.

• Restore can be used only when

there is no dialing data stored in

memory. Check that there is no

data in memory before trying to

restore data.

• Contact your service representa-

tive before performing the

restore operation.
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After confirming the name of the backup file you want to

restore, click [OK].

To change the backup file

You can leave the default backup file name as it is or change

it by clicking the [Browse] button, which opens a standard

Windows file name specification dialog box.

[Browse]

[Check
Program
Data]

[OK]
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Confirm that the name of the backup file is correct, then

click [OK] to restore the data.

 NoteNote
• Clicking Check Program Data

displays a dialog box that lets

you view data currently stored

in memory.
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TESTING FOR
PROPER OP-
ERATION

After completing all connections and settings, use the following

procedure to test NIC FAX for proper operation.

Testing for Proper Operation

Use the following procedure to send a mail message from NIC FAX to

your own computer and test for proper operation of the send and

receive functions.

If the send and receive functions do not operate properly, check

connections and try to locate the problem in the TROUBLESHOOT-

ING section starting from page 165 of this Operator’s Manual.

Make sure that the Memory

indicator is lit.

❐ If the Memory indicator is not lit, press the Memory key to

turn it on.

Place the document you

want to send face down

into the feeder, and set the

scanning parameters.

❐ Text is sent as Detail resolution (200 × 200 dpi), even if Fine

(200 × 400 dpi) is selected.

Press Mail.

❐ Make sure that the Mail indicator is lit.

❐ Pressing Mail while a document is not set on the feeder

causes an error tone to sound.

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

MEMORY TRANS.      OPTIONS  ↓

ENTER FAX NUMBER

           <G3>

MEMORY TRANS.      OPTIONS ↓

ENTER Mail ADDRESS       abc

           <Mail>
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MEMORY  TRANS.     OPTIONS ↓

PRESS YES OR CLR • NO

 design@abc.company.com

Use the Quick Dial keys and

Ten-Key Pad to input the

mail address you want to

send to.

❐ (@), period, underline, and hyphen can be input directly with

the Quick Dial keys. The symbols can be input when a Sym-

bol key is pressed. Use Shift to shift between upper-case

and lower-case characters.

❐ Letters and symbols will not be input if you press the Quick

Dial keys while the Mail indicator is not lit.

Press Yes.

❐ This confirms the mail address as shown on the display and

causes the Mail indicator to go out.

Press Start.

❐ This starts reading of the document into memory. The mail send

operation starts after the read operation is complete. The Com-

municating indicator is lit while a send operation is in progress.

❐ It may take some time before the send operation starts. This is

due to the time the machine requires to convert the data in

memory.

Check that the sent mail

was delivered properly.

❐ Note that mail is picked up in accordance with the Mail RX

Interval (page 58).

MEMORY  TRANS.     OPTIONS ↓ 

ENTER NO. OR START DEST:  2

            <G3>

STORING            MEMORY  98%

         PAGE 1

         FILE NO.3116

MEMORY TRANS. nicfax@abc.company.com

SET DOC. OR ENTER FAX NO.

                  MEMORY98%
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Testing Operation by Sending a Fax from a PC
FAX Application

After IC FAX Com Redirector, IC FAX Port, and Facsimile Modem

Type A03 are installed on your computer, you can use one of its

applications to send a fax to NIC FAX and to check for proper receipt.

See page 95 for details on how to send a fax from a PC FAX applica-

tion.
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TRANSMISSION A document can be read into IC FAX memory and sent as mail. The

mail address can be input manually, or using Quick Dial, Speed Dial,

or Group Dial. Mail can be sent to another fax compatible interned fax

machine or to a computer.

Using Manual Address Input

Make sure that the Memory

indicator is lit.

❐ If the Memory indicator is not lit, press the Memory key to

turn it on.

❐ The data for Internet fax transmissions must first be stored

into memory before it is sent. Immediate transmission is not

supported.

Place your document face

down into the feeder, and set

the scanning parameters.

❐ Messages are always sent as A4 size. If you feed wider docu-

ment than A4, it will be reduced in size to A4.

❐ Text is sent as Detail resolution (200 × 200 dpi), even if Fine

(200 × 400 dpi) is selected.

Press Mail.

❐ Make sure that the Mail indicator is lit.

❐ Pressing Mail while a document is not set on the feeder

causes an error tone to sound.

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

MEMORY TRANS.      OPTIONS  ↓

ENTER FAX NUMBER

           <G3>

MEMORY TRANS.      OPTIONS ↓

ENTER Mail ADDRESS       abc

           <Mail>
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Use the Quick Dial keys and

Ten-Key Pad to input the

mail address.

❐ (@), period, underline, and hyphen can be input directly with

the Quick Dial keys. The symbols can be input when a Sym-

bol key is pressed. Use Shift to shift between upper-case and

lower-case characters.

❐ Letters and symbols will not be input if you press the Quick

Dial keys while the Mail indicator is not lit.

Press Yes.

❐ This confirms the mail address as shown on the display and

causes the Mail indicator to go out.

❐ Repeat steps 3 through 5 if you want to input more.

Press Start.

❐ This starts reading of the document into memory. The mail

send operation starts after the read operation is complete. The

Communicating indicator is lit while a send operation is in

progress.

❐ With a long message, it may take some time before the trans-

mission starts. This is due to the time the machine requires to

convert the data in memory.

Note
• To cancel an Internet Fax, press

the Function key, followed by

the 2 and 1 keys.

• To cancel transmission, press the

Stop key.

 Note

MEMORY  TRANS.     OPTIONS ↓ 

PRESS YES OR CLR • NO

 nicfax1@abc.company.com

MEMORY  TRANS.     OPTIONS ↓ 

ENTER NO. OR START DEST:  2

            <G3>

STORING            MEMORY  98%

         PAGE 1

         FILE NO.3116

MEMORY TRANS. nicfax@abc.company.com

SET DOC. OR ENTER FAX NO.

                  MEMORY98%
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Using Quick Dial, Speed Dial, or Group Dial for
Address Input

Make sure that the Memory

indicator is lit.

❐ If the Memory indicator is not lit, press the Memory key to

turn it on.

Place your document face

down into the feeder, and set

the scanning parameters.

❐ Text is sent as Detail resolution (200 × 200 dpi), even if Fine

(200 × 400 dpi) is selected.

Use Quick Dial, Speed Dial,

or Group Dial to specify the

mail address.

❐ Quick Dial ... Press the applicable Quick Dial key. See page

129 of this manual and page 293 of the main Operator’s

Manual for details on using Quick Dial.

❐ Speed Dial ... Press Speed Dial/Tel Directory and use the

Ten-Key Pad to input the applicable two-digit Speed Dial. See

page 133 of this manual and page 296 of the main Operator’s

Manual for details on using Quick Dial.

❐ Group Dial ... Press the applicable Quick Dial key. See page

300 of the main Operator’s Manual for details on using Group

Dial.

 Note

Note
• With Group Dial, you can

assign a mixture of mail ad-

dresses and fax numbers to a

single Quick Dial key.

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

MEMORY TRANS.      OPTIONS  ↓

ENTER FAX NUMBER

           <G3>

MEMORY  TRANS.     OPTIONS ↓ 

PRESS YES OR CLR • NO

 nicfax1@abc.company.com
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Press Yes.

Press Start.

❐ This starts reading of the document into memory. The mail

send operation starts after the read operation is complete. The

Communicating indicator is lit while a send operation is in

progress.

❐ With a long message, it may take some time before the trans-

mission starts. This is due to the time the machine requires to

convert the data in memory.

MEMORY  TRANS.     OPTIONS ↓ 

ENTER NO. OR START DEST:  2

            <G3>

STORING            MEMORY  98%

         PAGE 1

         FILE NO.3116

MEMORY TRANS. nicfax@abc.company.com

SET DOC. OR ENTER FAX NO.

                  MEMORY98%
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BROADCASTING NIC FAX can send the same mail to multiple faxes or computers. The

broadcasting addresses can be a mixture of fax numbers and mail

addresses.

Make sure that the Memory

indicator is lit.

❐ If the Memory indicator is not lit, press the Memory key to

turn it on.

Place your document face

down into the feeder, and set

the scanning parameters.

❐ Text is sent as Detail resolution (200 × 200 dpi), even if Fine

(200 × 400 dpi) is selected.

Use the Quick Dial keys or

Ten-Key Pad to input the

mail address.

❐ Manual input ... Press Mail then use the Quick Dial keys and

Ten-Key Pad to input the mail address.

❐ Note that Letters and symbols will not be input if you press the

Quick Dial keys while the Mail indicator is not lit.

❐ (@), period, underline, and hyphen can be input directly with

the Quick Dial keys. The symbols can be input when a Sym-

bol key is pressed. Use Shift to shift between upper-case and

lower-case characters.

❐ Pressing Mail while a document is not set on the feeder

causes an error tone to sound.

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

MEMORY TRANS.      OPTIONS  ↓

ENTER FAX NUMBER

           <G3>

MEMORY TRANS.      OPTIONS ↓

ENTER Mail ADDRESS       abc

           <Mail>

MEMORY  TRANS.     OPTIONS ↓ 

PRESS YES OR CLR • NO

 nicfax1@abc.company.com
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❐ Quick Dial ... Press the applicable Quick Dial key.

❐ Speed Dial ... Press Speed Dial/Tel Directory key and use

the Ten-Key Pad to input the applicable two-digit Speed Dial.

❐ Group Dial ... Press the applicable Quick Dial key.

Press Yes.

❐ This confirms the mail address as shown on the display. It also

causes the Mail indicator to go out (if using manual input).

Repeat steps 3 through 5 to

input all the mail addresses

you want.

 Note

MEMORY  TRANS.     OPTIONS ↓ 

ENTER NO. OR START DEST:  2

            <G3>

MEMORY TRANS.      OPTIONS ↓

ENTER Mail ADDRESS       abc

           <Mail>

 Note
• You can input up to 200 ad-

dressees, mixing mail addresses

and fax numbers. Note that the

maximum number of addressees

may be further limited by your

mail server.

• See page 18 of the main Opera-

tor’s Manual for details on

specifying addressees using user

function keys.

Press Start.

❐ This starts reading of the document into memory. The mail

send operation starts after the read operation is complete. The

Communicating indicator is lit while a send operation is in

progress.

❐ It may take some time before the transmission starts. This is

due to the time the machine requires to convert the data in

memory.

STORING            MEMORY  98%

         PAGE 1

         FILE NO.3116

MEMORY TRANS. nicfax@abc.company.com

SET DOC. OR ENTER FAX NO.

                  MEMORY98%
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TRANSFER RE-
QUEST

You can use Quick Dial, Speed Dial, or Group Dial to send to a transfer

station previously assigned to the applicable key or code. There are two

types of transfer request transmission: transfer request by mail and

transfer request by fax (standard transfer request transmission).

The following are some terms you must be familiar with in order to

perform the following procedure.

❐ Transfer requester.......... This is the fax machine performing the

transfer request transmission (NIC FAX).

❐ Transfer station .............. This is the fax machine, which is

equipped with transfer capabilities, that is

requested to perform a transfer.

❐ End receiver .................. This is the fax machine or computer that

receives the mail or fax from the transfer

station.

 Note 1

Note 1
• Only a NIC FAX can be speci-

fied as the transfer requester for a

transfer request by mail.

• See page 51 of the main Opera-

tor’s Manual for details on the

operation for transfer request by

fax.

 Transfer Request by Mail

 Note 2

Note 2
• Up to 99 transfer stations can be

specified for each transfer

request.

• Up to 30 end receivers can be

specified for each transfer

station.

• Each transfer station Group is

counted as a single end receiver.

• Up to a total of 100 transfer

stations can be specified by end

receiver specification and Ten-

Key input. Mail Server
 Router

ComputerComputer Computer

G3 Fax Printer

Printer

NIC FAX 2

NIC FAX 1

nicfax2@abc.company.com

+Quick Dial (#01) input

nicfax2@abc.company.com

nicfax1@abc.company.com
Mail Server

Router

 Computer  Computer Computer

Internet

LAN

LAN

Europe
 End Receiver

Transfer Station

Transfer Requester

North America
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 Note 1Note 1
• Before performing the follow-

ing procedure, you must first

store the polling ID for your fax

machine and its telephone

number. The same polling ID

must be stored for both the

transfer requester (NIC FAX)

and the transfer station.

• See page 49 of the main Opera-

tor’s Manual for details on using

Function 61 to store the polling

ID (ID code).

Make sure that the Memory

indicator is lit.

❐ If the Memory indicator is not lit, press the Memory key to

turn it on.

Place your document face

down into the feeder, and set

the scanning parameters.

❐ Text is sent as Detail size, even if Fine is selected.

Press Function.

❐ If a function screen is already on the display, press No.

❐ See page 4 of the main Operator’s Manual for details on the

sequence that functions are displayed.

Press 1 3.

 Note 2

Note 2
• Sending a transfer request

transmission to a fax that does

not have a transfer function or

to a computer by mail is sent as

a normal transmission to and

received by the transfer station

without being transferred to any

other destination. Note that no

error report is returned to the

transfer requester (the originator

of the transmission). Because of

this you should always confirm

that the transfer station is a fax

that is equipped with a transfer

function.

In Putting a Mail Address Stored in a Quick Dial/Speed Dial.

Use Quick Dial or Speed

Dial to specify the transfer

station.

❐ Quick Dial

Press the Quick Dial to which the desired address is as-

signed.

❐ Speed Dial

Press Speed Dial/Tel Directory use the Ten-Key Pad to input

the applicable Speed Dial.

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

MEMORY TRANS.      OPTIONS  ↓

ENTER FAX NUMBER

           <G3>

FUNCTION      NO.:YES OR NO

10TRANS. MODE  20CLEAR CHANGE 

30PROG.CHANGE  40REPORTS    ↓

TRANSFER           OPTIONS ↓

TRANSFER.  1       <G3>

TRANSFER PRESS YES OR CLR • NO

TRANSFER.  1   57 design

RECV       1
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Inputting a Mail Address Manually

 (1) Press Mail.

❐ Make sure that the Mail indicator is lit.

❐ Pressing Mail while a document is not set on the feeder

causes an error tone to sound.

 (2) Input the mail address.

❐ (@), period, underline, and hyphen can be input directly with

the Quick Dial keys. The symbols can be input when a Sym-

bol key is pressed. Use Shift to shift between upper-case and

lower-case characters.

❐ Pressing Clear deletes the character at the current cursor posi-

tion.

❐ Pressing No clears the address.

Press Yes.

Specify the end receiver

and then press Yes.

❐ See page 81 of this Operator’s Manual for details about speci-

fying end receivers.

TRANSFER           OPTIONS ↓

TRANSFER.  1      <Mail>     

TRANSFER           OPTIONS ↓

TRANSFER.  1 nicfax2          

abc

TRANSFER           OPTIONS ↓

TRANSFER. 1 nicfax2@abc.company.com 

RECV      1
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After finishing all the re-

quired input, press Start.

❐ This starts reading of the document into memory. The mail

send operation starts after the read operation is complete. The

Communicating indicator is lit while a send operation is in

progress.

❐ It may take some time before the send operation starts. This is

due to the time the machine requires to convert the data in

memory.

STORING            MEMORY  98%

         PAGE 1

         FILE NO.3116

MEMORY TRANS. nicfax@abc.company.com

SET DOC. OR ENTER FAX NO.

                  MEMORY98%
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Transfer Request by Fax

See page 51 of the main Operator’s Manual for details on sending a

transfer request by fax.

Specifying an End Receiver Station

Only end receivers whose mail addresses or fax numbers are pro-

grammed as Quick Dial, Speed Dials, or Group Dials on the transfer

station can be specified as end receivers. Data for addressees speci-

fied as end receivers is sent to the mail addresses or fax machines

registered on the transfer station.

❐ Quick Dial

Press # and then input the applicable two-digit Quick Dial code.

Example : To specify the end receiver assigned to Quick Dial code

01 on the transfer station.

Enter : # 0 1

❐ Speed Dial

Press # *  and then input the applicable two-digit or three-digit

Speed Dial.

Example : To specify the end receiver assigned to Speed Dial 12

on the transfer station.

Enter : # *  1 2

Example : To specify the end receiver assigned to Speed Dial 123

on the transfer station.

Enter : # *  1 2 3

❐ Group Dial

Press # * *  and then input the applicable two-digit Group Dial code.

Example : To specify the end receiver assigned to Group 04 on

the transfer station.

Enter : # * *  0 4
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RECEPTION Receiving Mail

NIC FAX automatically accesses the mail server to receive mail. Mail

RX interval is set to three minutes at the factory, but this can be

changed to any interval within the range of one to 60 minutes.

❐ See page 58 of this Operator’s Manual for information about

changing the mail receive interval setting.
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Mail Server

Router

 Broadcasting 
    Sequence

ComputerComputer Computer
 G3 Fax

 G3 Fax

 G3 Fax

Printer

Printer

NIC FAX 2

NIC FAX 1

Mail Server

Router

ComputerComputer Computer

Internet

LAN

LAN

nicfax2@abc.company.com

nicfax1@abc.company.com

design@abc.company.com

Receiving Transfer Request Mail

When NIC FAX receives a transfer request transmission by mail, it

transfers the mail to all the end receivers specified in the mail.

❐ Note that the an optional memory card or hard disk unit is required

to receive transfer request mail.

Transfer request mail from NIC FAX 1 is received by NIC FAX 2 and

sent to the specified end receivers.
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 Note 1Note 1
• For Mail from a computer,

alphabetic-character text and

TIFF-F/DCX images are output

they are. If you receive nonal-

phabetic text, it may not be

printed normally.

• Mail is not picked up when free

memory is low. In this case,

mail pickup will be performed

once sufficient free memory

becomes available.

• Mail addresses can also be

specified as end users.

• Transfer request mail requires

setting of the polling ID and end

receiver address or fax phone

number. The end receiver

address or fax phone number

must be assigned to a Quick

Dial, Speed Dial, or Group Dial.

Multi-step Transfer Example

Transfer request transmission becomes even more effective when it is

performed through multiple transfer stations.

Once a transfer station is assigned to a Group, specifying that group as

the end receiver causes a transfer request transmission to send the

document to the assigned transfer station. The mail addresses and fax

numbers assigned to the specified Group become end receivers.

Contact your local service representative for full details.

 Note 2

Note 2
• If a specified Group Dial that is

programmed as the end receiver

is set for Multi-step Transfer at

the transfer station, the transfer

station passes on the document

to the destination.
G3 Fax

Mail Server

ComputerComputer Computer

Router

Transfer

ComputerComputer Computer

Printer

NIC FAX 2

Router

Internet

Telephone 
Network

Mail Server

Printer

NIC FAX 1

G3 Fax

Telephone 
Network

nicfax2@abc.company.com

nicfax1@abc.company.com
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Routing of Received Faxes

Four-digit Personal function codes (SUB) appended to faxes sent from

G3 machines are compared with Personal Codes programmed on the

NIC FAX. A matching code causes the fax to be routed to the destina-

tion assigned to the Personal Code.

See pages 111 and 142 of this Operator’s Manual for details on

programming routing destinations.

 NoteNote
• See page 18 of this manual for

details on routing of received

faxes.

"Routing of a Received

      Document to a Computer"

.......................... See to p.18 

• NIC FAX supports routing of

faxes received from another NIC

FAX or other types of fax

machines.

• Routing results are not informed

to the routing requester machine.
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Forwarding of Received Faxes

See page 109 of the main Operator’s Manual for details on program-

ming forwarding destinations.

❐ See page 19 of this Operator’s Manual for details on forwarding of

received faxes.
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REPORTS AND
LISTS

The formats of most reports and lists are identical to those output for

the standard fax functions. This section describes only reports and

lists that have different formats.

 Note 1Note 1
• When you send a fax to a mail

address, the field where the fax

number normally appears in a

standard fax report or list is

replaced by the applicable mail

address.

Transfer Result Report

When a transfer result request is sent by mail to a transfer station, this

report is sent by mail to the transfer requester to inform it of the result

of the transmissions as soon as they are all complete.

 Note 2Note 2
• See page 60 for details on how

to turn printing of header

information on and off

"Other Settings"

......................... See to p.60 .

***** Mail INFORMATION ************************ 24.SEP. 1998 11:26 ***********************

From: nicfax 1@abc.company.com

Subject: Fax Message from “1234”(“nicfax RTI”)

*************************************************************************************************

  ******** TRANSFER RESULT REPORT ( 24.SEP. 1998 ) ********

TRANSFER STATION   nicfax 1@ abc.company.com

TRANSFER REQUESTED TIME     1.23   11:25

ADDRESS(GROUP) PAGE RESULT

Mail : nicfax@ccc.company.com 1 – –

G3 : 212-1234-45678 1 OK

[RESULT]

OK : All pages sent (fax transmission).

E : Error

– – : Internet fax sent to mail server registered for this machine. This

does not indicate that the mail reached the final destination.
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Error Mail Notification

NIC FAX sends this notification to a sender when it is unable to suc-

cessfully receive a particular mail message. A cc of this notification is

also sent to the administrator mail address when one is specified.

❐ See page 60 for details on specifying the administrator mail ad-

dress.

***** Mail INFORMATION ************************** 24.SEP. 1998 11:26  *********************

From: nicfax 1@abc.company.com

Subject: Fax Message from “1234”(“nicfax RTI”)

*************************************************************************************************

******** ERROR MAIL NOTIFICATION  ( 24.SEP. 1998 )  ********

NOTIFICATION FROM nicfax 1@ abc.company.com

CAUSE OF ERROR  DECODE ERROR (INVALID FILE)

PLEASE CONFIRM

THANK YOU

 Note

Note
• NIC FAX also prints an Error

Report when it sends an Error

Mail Notification.

• See page 168 of the main

Operator’s Manual for details on

error reports.

Error Report (Mail)

This report is printed on NIC FAX when it is unable to send an Error

Mail Notification.

  ******** ERROR REPORT (Mail) ( 24.SEP. 1998 11:26 ) ********

TTI design

FILE TIME ADDRESS

*************************************************************************************************

0009  11:26 nicfax 1@ abc.company.com

PLEASE SEND THIS REPORT TO THE ABOVE ADDRESS.

CAUSE OF ERROR:            DECODE ERROR (INVALID FILE)
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Server-generated Error Mail from the Server

The transmitting server sends this error mail to the originator of mail

that cannot be transmitted correctly due to an incorrect mail address

or some other reason.

****   Mail INFORMATION   **************************  24.SEP. 1998 11:21 ********************

From: MAILER-DAEMON

Subject: Returned mail : User unknown

*************************************************************************************************

Received: from localhost (localhost) by aaa.company.com (8.6.11+2.4W/3.3W9-1.OS8Sun)

Date: Thu. 24.SEP. 1998  11:18:15+0900

From: Mail Delivery Subsystem (MAILER-DAEMON)

Subject: Return mail: User unknown

Message-Id:(12345678.LAA12345@aaa.company.com)

To <icfax@aaa.company.com >

The original message was received at Fri. 19 Jun 1998 11:25:02 +0900

From abc.company com[192.168.15.16]

  — — — — — The following addresses had delivery problems — — — — —

 < icfax@bbb.company.com >  (unrecoverable error)

  — — — — — Transcript of session as follows — — — — —

. . . . while talking to aaa.company.com:

> > > RCPT To: < icfax@bbb.company.com > ... User unknown

< < < 550Action not taken. supported local user icfax@ bbb.company.com does not exist.

550 < icfax@bbb.company.com >... User unknown

 — — — — —Original message follows — — — — —

Return-Path: icfax@bbb.company.com

Received: from icfax@bbb.company.com  (abc.company.com [192.168.15.16] by are

Massage-Id:  (12345678.LAA12345@aaa.company.com)

Date: 19 Jun 1998 11: 20:21 +0900

X-Mailer: ICFAX Version 1.0

Content-Type: multipart/mixed: boundary=” — — ICFAX_60678ADCFI — — ”

To: icfax@bbb.company.com

From: icfax@ aaa.company.com

Subject: Fax Message from “1234”

   (F64G-S RTI”)

Example Printout of Server-generated Error Mail

 Note

Note
• Printing of server-generated

error mail is followed by

printing of the first page of the

document.
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Journal

*   *   *   JOURNAL  ( 24.SEP. 1998  15:12 )   *   *   *

TTI ABC.COMPANY

<TX>

DATE TIME ADDRESS MODE TIME PAGE RESULT PERS. NAME FILE

— — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — —

24.SEP. 10:19 New York Branch G3EDM 0’41” P.1 OK design 0528

11:45   PC--<LAN>--> G3DM 0’05” P.2 OK 0529

13:46 nicfax1@abc.company.com MailDM 0’45” P.2 — — 0530

14:47 nicfax2@abc.company.com MailDM 0’15” P.1 — — 001 0531

14:48 nicfax3@abc.company.com MailDM 2’22” P.1 — — 111 0532

15:08 nicfax4@abc.company.com MailDM 0’15” P.1 E 0533

<RX>

DATE TIME ADDRESS MODE TIME PAGE RESULT PERS. NAME FILE

— — — — — — — — — — — — —  — — — — — — — — — — — — — — — — — — — — — — —

24.SEP. 9:37 New York Branch G3ES 0’06” P.1 OK design 0558

11:19   PC--<LAN>--> MailSM 0’15” P.1 OK 0559

12:45 nicfax5@abc.company.com MailSM 0’08” P.1 OK 0560

15:01 nicfax6@abc.company.com MailSM 0’01” P.1 E 0001 0561

15:09 nicfax7@abc.company.com MailSM 0’02” P.1 OK 1111 0562

S C N         000636 P R T        002318 T X         006535 R X        000838

# : BATCH C : CONFIDENTIAL $ : TRANSFER P : POLLING

M : MEMORY L : SEND LATER @ : FORWARDING E : ECM

S : STANDARD D : DETAIL F : FINE > : REDUCTION

!S : REMOTE TRANSFER N : PABX + : ROUTING

[DATE]

Date of communication.

[TIME]

Time communication started.

[ADDRESS]

In the case of mail transmission, this column shows the address that

was input manually, or the name assigned to the Quick Dial or Speed

Dial that was used.

In the case of mail reception, this column shows the address that was

in the From field of the received mail.

In the case of communication with another fax, the contents of this

column are identical to those of the standard fax journal.
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[MODE]

Letter or symbol indicating the communication mode.

[TIME]

Elapsed time. * * :* *  is shown if the elapsed time exceeds 99 min-

utes 59 seconds.

[PAGE]

Number of pages. * * *  is shown if the number of pages exceeds

999.

[RESULT]

OK : All pages sent (fax transmission).

E : Error

- - : Internet fax sent to mail server registered for this machine. This

does not indicate that the mail reached the final destination.

D : Power outage

[PERSONAL NAME]

Personal name or Personal Code for communication with Personal

Code specified. The personal name is shown here when one is pro-

grammed.

[FILE]

File number (document control number)
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Personal Code List

*   *   *   PERSONAL CODE LIST  ( 24.SEP. 1998  15:12 )   *   *   *

TTI ABC.COMPANY

PERS. QUICK

CODE CONFID’LID PERS.NAME KEY ROUTING ADDRESS

— — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — — —

0001 1234 design PC 36 QUICK DIAL 08 Mail : design

0011 NORTON PC 12 QUICK DIAL 01 Mail : NORTON

0154 Micky PC 44 QUICK DIAL 09 Mail : ARMSTRONG

2222 Mike PC 56 QUICK DIAL 03 Mail : Philadelphia

3333 Jon PC 45 QUICK DIAL 05 Mail : Chicago

[PERSONAL CODE]

Personal Codes programmed on the machine

[CONFIDENTIAL ID]

Confidential IDs, when programmed

[PERSONAL NAME]

Personal names, when programmed

[QUICK DIAL KEY]

Quick Dial to which Personal Codes are assigned

[ROUTING DESTINATION]

Routing destinations, when programmed
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You can use NIC FAX as a simplified network scanner by sending a

document to your own mail address.

❐ For this operation you can select between Standard resolution

(200 × 100 dpi) and Detail resolution (200 × 200 dpi).

Make sure that the Memory

indicator is lit.

❐ If the Memory indicator is not lit, press the Memory key to

turn it on.

Place the document you

want to scan face down into

the feeder, and set the

scanning parameters.

❐ Text is sent as Detail resolution (200 × 200 dpi), even if Fine

(200 × 400 dpi) is selected.

Press Mail.

❐ Make sure that the Mail indicator is lit.

❐ Pressing Mail while a document is not set on the feeder

causes an error tone to sound.

❐ It is not necessary to press Mail if you plan to use Quick Dial

or Speed Dial to input the address.

❐ To input the address, you could also use Quick Dial if your

mail address is programmed to one.

(In this case, skip step 3.)

❐ To input the address, you could also press Speed Dial/Tel

Directory and then input a Speed Dial if your mail address is

programmed to one.

(In this case, skip step 3.)

SIMPLE SCAN-
NING OPERA-
TION

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

MEMORY TRANS.      OPTIONS  ↓

ENTER FAX NUMBER

           <G3>

MEMORY TRANS.      OPTIONS ↓

ENTER Mail ADDRESS       abc

           <Mail>
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Use the Quick Dial keys and

Ten-Key Pad to input the

mail address you want to

send to.

❐ (@), period, underline, and hyphen can be input directly with

the Quick Dial keys. The symbols can be input when a Sym-

bol key is pressed. Use Shift to shift between upper-case and

lower-case characters.

❐ Letters and symbols will not be input if you press the Quick

Dial keys while the Mail indicator is not lit.

Press Yes.

❐ This confirms the mail address and causes the Mail indicator

to go out.

Press Start.

❐ This starts reading of the document into memory. The mail

send operation starts after the read operation is complete. The

Communicating indicator is lit while a send operation is in

progress.

❐ It may take some time before the send operation starts. This is

due to the time the machine requires to convert the data in

memory.

MEMORY  TRANS.     OPTIONS ↓ 

PRESS YES OR CLR • NO

 nicfax1@abc.company.com

MEMORY  TRANS.     OPTIONS ↓ 

ENTER NO. OR START DEST:  2

            <G3>

MEMORY TRANS. nicfax@abc.company.com

SET DOC. OR ENTER FAX NO.

                  MEMORY98%
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NIC FAX lets you send a fax of a document created on your computer

using IC FAX Com Redirector and a PC fax application.

 Note 1

USING A PC FAX
APPLICATION
Note 1
• See the documentation that

comes with your PC fax applica-

tion for details on how to install

it.

• See page 156 of this Operator’s

Manual for details about IC

FAX Com Redirector.

"IC FAX Com Redirector"

....................... See to p.156  

• NIC FAX can also receive

simultaneous transmission

requests from two different

computers.

PC FAX Application

Be sure to use a PC Fax application that supports Class 2 AT com-

mands, such as Microsoft FAX. Contact your sales or service representa-

tive for details on PC FAX applications that are compatible with NIC FAX.

 Note 2

Note 2
• A PC fax application cannot be

used to receive a fax. Be sure to

turn off its auto receive setting if

it has one.
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Sending a PC Fax

The following example shows how to send a PC FAX using Microsoft

FAX. See the documentation that comes with Windows 95 for full

details on Microsoft FAX.

On the [Start] menu, point to [Programs], [Accessories], and

[Fax], and then click [Compose New Fax].

❐ This displays a dialog box for creation of a new message.

Type in the number of the fax machine to which you want to send.

❐ You can also specify the number by inputting a NIC FAX Quick

Dial, Speed Dial, or Group Dial. If a mail address is assigned

to the Quick Dial, Speed Dial, or Group Dial, the message is

sent as mail.

❐ Quick Dial

Input # followed by a two-digit Quick Dial Code. For Quick Dial

code 12, input: #12.

❐ Speed Dial

Input #*  followed by a two-digit Speed Dial. For Speed Dial

23, input: #* 23.

[Next]
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❐ Group Dial

Input #* *  followed by a two-digit Group Dial Code. For Group

Dial code 05, input: #* * 05.

 Note 1

Note 1
• Be sure to input a leading zero to

change one-digit numbers into

two-digit numbers. For example,

input 5 as 05.

• When an optional FUNCTION

UPGRADE CARD TYPE140 is

installed, you must input three

digits for Speed Dials. This

means you must input two

leading zeros to change one-digit

numbers into three-digit num-

bers.

• Typing in 0000 for the fax

number outputs to the NIC FAX

you are sending from.

 Follow the instructions that appear on the screen.

 Note 2

Note 2
• As with standard faxing from

NIC FAX, TTI (Transmit

Terminal Identification) infor-

mation, addressee names

assigned to the Quick Dial or

Speed Dial, and personal name

(destination name) are included

with PC fax transmissions,

except when sending to your

own machine (fax number

0000).

Sending a PC Fax of a Document Created with a Word Processor or

Other Application

On the [File] menu, click [Print].

Select Microsoft FAX or the name of the PC fax application

you are using as the printer name.

Follow the instructions that appear on the display.
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FUNCTION 25 -
ERASING PC
FAX TRANSMIS-
SION

Perform the following procedure to cancel a PC FAX transmission.

Press Function 25.

❐ If a previous function screen is already shown, you need to

press No followed by 3 then 1 instead.

Press ∞ to select the file

you want to cancel, and

then press Yes.

Press Yes.

Press Function.

 Note

Note
• You can use this procedure to

cancel a PC FAX transmission

while NIC FAX is accepting a

PC FAX transmission, in the

stand-by mode, or sending a fax.

• Use Function 21 to cancel an

Internet fax.

• An IC FAX transmission can be

interrupted by pressing Stop.

10TRANS.MODE  20CLEAR CHANGE

30PROG.CHANGE 40REPORTS ↓

-
FUNCTION     N:     OR  NO 

PC-FAX FILE       SCROLL   ↓

             PRINT LIST →

NO TO CANCEL

FILE NO.:

LAST FILE :0002

PC-FAX FILE       SCROLL ↑

12345678

↓

NO.0002   STANDBY  PRESS  YES

PC-FAX FILE  

NO.0002

CLEAR FILE?  YES • NO
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FUNCTION 31 -
PROGRAMMING
QUICK DIALS

Once a destination fax number or mail address is assigned to a Quick

Dial key, you can input the fax number or address by simply pressing

the key or inputting its code. Turning on label insertion automatically

prints the programmed name on the first page of the document.

Assigning an Auto Document to a Quick Dial key to which a destina-

tion is assigned appends the Auto Document to the fax being sent

with the touch of a key. This is called a Personal Auto Document. See

page 68 of the main Operator’s Manual for details.

 NoteNote
• Always use the procedure on

page 63 of this Operator’s

Manual to back up data before

programming new data or

editing existing data.

.......................... See to p.63 
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Quick Dial Key Programming

QUICK DIAL KEY PROGRAMMING

Enter the Quick Dial programming mode.

Press Function 31.

Display the number of the Quick Dial key you want to program, edit, or delete.
Press a Quick Dial key or use ∞ or 5 to search for the number.

Mail address programming Fax number programming Edit Delete

Press Mail.
Use the Ten-Key Pad to
input the fax number.

Change the exist-
ing mail address
or fax number.
Press Yes if you
don’t want to make
any changes.

Press Function to return to the original display.

Delete the existing data.

Specify whether or not you want to insert a label.

Change the existing
name.
Press Yes if you don’t
want to make any
changes.

Program a name.
Press Yes if you don’t want to
program a name.

Input a mail address.
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Programming a New Quick Dial

See page 293 of the main Operator’s Manual for details on program-

ming standard fax machine phone numbers.

The following data can be programmed to a Quick Dial key.

❐ Destination mail address and name

❐ Label insertion on and off

 Note

F4 F5

01 02 03 04 05 06 07 08

09 10 11 12 13 14 15 16

17 18 19 20 21 22 23 24

25 26 27 28 29 30 31 32

A B C D E F G H

I J K L M N O P

Q R S T U V W X

Y Z

StampF1 F2 F3

Space ShiftSymbol

ShiftSymbol@ -_.

QUICK DIAL      CHOOSE KEY

PRINT LIST  →

 NO TO CANCEL

_

QUICK DIAL    YES OR CLR • NO

↑

↓

41

QUICK DIAL    YES OR NO

↑

↓

45 L.AA

1765900 L.A

Note
• You can also make settings with

IC FAX Monitor. See page 129

of this Operator’s Manual for

details.

......................... See to p.129 

Press Function 31.

❐ If a previous function screen is already shown, you need to

press No followed by 3 then 1 instead.

Press the Quick Dial key you want to program.

❐ If you press the wrong key,

press No or use 5 and ∞

to scroll to another key.

❐ A screen like the one to the

right appears if the key

already has data assigned

to it. Use 5 and ∞ to search

for a different Quick Dial key

that is not programmed yet.
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Press Yes.

Press Mail.

❐ This causes the Mail indicator to light.

Input the mail address you

want to assign to the key.

❐ (@), period, underline, and hyphen can be input directly with

the Quick Dial keys. The symbols can be input when a Sym-

bol key is pressed. Use Shift to shift between upper-case and

lower-case characters.

❐ Pressing Clear deletes the character at the current cursor

position.

❐ Pressing No clears the address.

Press Yes.

❐ This saves the mail address and causes the Mail indicator to

go out.

Input the destination label.

❐ If you do not want to program a label, press Yes and skip to

step 10.

QUICK DIAL   ENTER FAX NUMBER

41    <  G3  > NO TO CANCEL

 L.A

QUICK DIAL   ENTER Mail ADDR.

41    < Mail > NO TO CANCEL

 L.A

QUICK DIAL   YES OR CLR • NO

41    <  Mail  >

 XXX@abc.company.com

QUICK DIAL   ENTER LABEL

-

41             NO TO CANCEL

                        abc

QUICK DIAL   ENTER LABEL

41             NO TO CANCEL

 XXXX                   abc
-
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Press Yes.

Turn label insertion on or off.

❐ Use 2 and 3 to move the highlighting between ON and OFF.

Press Yes.

Press Function.

Using Quick Dial to Send a Document

1. Place your document face down into the feeder, and set the scan-

ning parameters.

2. Press the Quick Dial key to which the destination where you want

to send the document is programmed.

This causes the destination name and mail address to appear on

the display.

3. After checking that the destination is correct, press Yes.

4. Press Start.

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

QUICK DIAL    CHOOSE KEY

                PRINT LIST →

                NO TO CANCEL-

QUICK DIAL    OPTION SETTING

LABEL INSERTION  ON  OFF

         SELECT ← → YES TO END

QUICK DIAL    OPTION SETTING

LABEL INSERTION  ON  OFF

         SELECT ← → YES TO END
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Editing Quick Dial

Use the following procedure to edit data already programmed to a

Quick Dial key.

 NoteNote
• The data of a Quick Dial key

that is currently being used by a

fax that is in memory standing

by for transmission cannot be

edited.

Press Function 31.

❐ If a previous function screen is already shown, you need to

press No followed by 3 then 1 instead.

Press the Quick Dial key

you want to edit.

❐ If you press the wrong key, press No or use 5 and ∞ to scroll

to the key you want.

❐ While this screen is on the display, you can press 3, use the

Ten-Key Pad to input 1 for a Quick Dial List or 2 for a Quick

Dial Label, and then press Start to print the selection.

Press Yes.

Press Mail.

❐ Make sure the Mail indicator is lit.

❐ If a mail address is already assigned to the key, it appears on

the display automatically in step 3. In this case, you do not

need to perform step 4.

QUICK DIAL      CHOOSE KEY

PRINT LIST  →

 NO TO CANCEL

_

QUICK DIAL    YES OR NO

↑

↓

01 L.A

XXXXXXX

QUICK DIAL   YES OR CLR • NO

01     <   Mail  >

 XXXXXXX 
-

QUICK DIAL   YES OR CLR • NO

01     <   Mail  >

 XXXXXXX 
-
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Edit the mail address on the

display.

❐ (@), period, underline, and hyphen can be input directly with

the Quick Dial keys. The symbols can be input when a Sym-

bol key is pressed. Use Shift to shift between upper-case and

lower-case characters.

❐ Pressing Clear deletes the character at the current cursor

position.

❐ Pressing No clears the address.

Press Yes.

❐ This saves the mail address and causes the Mail indicator to go out.

Use Clear or No then re-

input the label.

❐ If you do not want to change the label, jump to step 8.

❐ See page 220 of the main Operator’s Manual for details on

storing names.

Press Yes.

Turn label insertion on or off.

❐ Use 2 and 3 to move the highlighting between ON and OFF.

❐ See page 88 of the main Operator’s Manual for details on

label insertion and the inputting text.

QUICK DIAL   YES OR CLR • NO

01     <   Mail  >

 XXXXX 
-

QUICK DIAL   YES OR CLR • NO

01 

 XXXXX 
-

QUICK DIAL   YES OR CLR • NO

01 

 
-

QUICK DIAL    OPTION SETTING

LABEL INSERTION  ON  OFF

         SELECT ← → YES TO END

QUICK DIAL    OPTION SETTING

LABEL INSERTION  ON  OFF

         SELECT ← → YES TO END



USING FUNCTIONS

IC FAX Com 
Redirector

TROUBLESHOOTING

APPENDIX

GLOSSARY

INTERNET FAXING

GETTING READY

GETTING AQUAINTED
WITH NIC FAX

IC FAX Monitor

Contents

Index

107

USING FUNCTIONS

Press Yes.

Press Function.

Erasing a Quick Dial

Use the following procedure to delete data already programmed to a

Quick Dial key.

Press Function 31.

❐ If a previous function screen is already shown, you need to

press No followed by 3 then 1 instead.

Press the Quick Dial key

whose data you want to

delete.

❐ If you press the wrong key, press No or use 5 and ∞ to scroll

to the key you want.

❐ While this screen is on the display, you can press 3, use the

Ten-Key Pad to input 1 for a Quick Dial List or 2 for a Quick

Dial Label, and then press Start to print the selection.

Press Yes.

Press No.

QUICK DIAL    CHOOSE KEY

                PRINT LIST →

                NO TO CANCEL-

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

QUICK DIAL      CHOOSE KEY

PRINT LIST  →

 NO TO CANCEL

_

QUICK DIAL    YES OR NO

↑

↓

01 L.A

XXXXXXX

QUICK DIAL   YES OR CLR • NO

01     <   Mail  >

 XXXXXXX 
-

QUICK DIAL   YES OR CLR • NO

01     <   Mail  >

  
-
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Press No.

❐ This deletes the data.

Press Function.

Speed Dial and Group Dial

Similar procedures as described above can be used to program

Speed Dial and Group Dial mail addresses. See page 296~304 of the

main Operator’s Manual for details on programming fax numbers.

QUICK DIAL      CHOOSE KEY

PRINT LIST  →

 NO TO CANCEL

_

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%
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FUNCTION 63 -
USER PARAM-
ETERS

User Parameters appear on the display as a series of on/off switches

that can be used to configure a number of features.

❐ When installation of options or functions requires other on/off

settings besides User Parameter settings, make the other settings

first before making the User Parameter settings.

❐ The factory default setting is _ (underline).

Switches and Bits

❐ Each User Parameter switch represents a bit (digit) of an eight-bit

binary number. Each bit is referred to by its relative position, with

bit 0 on the far right and bit 7 on the far left. Each bit can be either

0 or 1, and the status of each function is determined by the value

of the corresponding bit.

Switch : 0 0 : 0 1 0 0 0 0 0

• • • • • • •

• • • • • • •

7 6 5 4 3 2 1 Bit numbers
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 NoteNote
• See page 223 of the main Opera-

tor’s Manual for details on making

User Parameter settings.

• See page 175 of the main Opera-

tor’s Manual for details on how to

print a User Parameter List. The following table shows User Parameter switches for IC FAX mail.

Switch Bit Item Settings Page

14

LAN-PC FAX
2 Normal TTI printing 1: Print     0: Do not print P.30, 267

 Switch Bit                Item                          Description

02 0 Forwarding mark printing This setting specifies whether or not a forward-

ing mark should be appended to images of re-

ceived mail that is forwarded or routed.

1 Centre mark printing

2 Reception time printing

3 TSI printing Printing of the mail address in the From field of

received mail.

4 Checkered Mark printing

06 0 Normal TTI printing

4 Batch transmission Mail transmission does not support batch Trans-

mission, but when this switch is turned on, the

same mail can be batch sent to multiple desti-

nations. When this switch is off, mail is sent to

individual destinations.

10 0 Reverse order printing

1 TOIN-1 Image Rotation
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FUNCTION 71 -
PROGRAMMING
THE PERSONAL
CODES
(ROUTING
ADDRESSES)

Routing addresses are compared with four-digit Personal Codes

received from G3 fax machines, and messages are routed accord-

ingly. See page 18 of this manual for details.

❐ A name can be assigned to each Personal Code.

❐ You can select whether or not to assign Personal Codes to Quick

Dial keys. When they are, a Personal Code can be specified by

pressing the applicable Quick Dial key.

❐ For details on inputting Personal Codes for transmission, see page

28 of the main Operator’s Manual.

❐ When Restricting Access to the Machine (page 75 of the main

Operator’s Manual), machine operations are disabled unless the

operator is able to input the proper Personal Code.

❐ Printout of a Personal Code List is recommended after you pro-

gram or edit Personal Code data. Keep this list handy for later

reference when required.

Programming a Personal Code

Press Function 60.

❐ If a previous function screen is already shown, you need to

press No followed by 6 then 0 instead.

❐ See page 4 of the main Operator’s Manual for details on the

sequence that function screens appear on the display.

Press 222271.

❐ While this screen is on the display, you can print a Personal

Code list by pressing 3 and then Start. See page 92 of this

Operator’s Manual for details on the Personal Code List.

SYSTEM SET

NO TO CANCEL
-

PERS. CODE     ENTER ID CODE

NO TO CANCEL
-

PRINT LIST →
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Use the Ten-Key Pad to

input a four-digit Personal

Code.

❐ You can use any number from 0 to 9 in each digit of the Per-

sonal Codes. The only restriction is that you are not allowed to

program a Personal Code of 0000.

❐ If you make a mistake during input, press No and input again.

Press Yes.

Press the Quick Dial key to

which you want to assign

the Personal Code.

❐ Skip this step if you don’t want to assign the Personal Code to

a Quick Dial key.

Press Yes.

Input the name you want to

assign to the Personal

Code.

❐ You can input up to 20 characters per name. A character can

be an alphabetic character, symbol, number, or space.

❐ See page 220 of the main Operator’s Manual for details on

storing names.

❐ If you do not want to program a label, skip to step 9.

Press Yes.

PERS. CODE     YES OR NO

0001

PERS. CODE    CHOOSE KEY

0001

YES TO SKIP NO TO CANCEL
-

PERS. CODE     YES OR NO

0001

16

PERS. CODE     ENTER LABEL

0001             NO TO CANCEL

                       ABC
-

PERS. CODE     ENTER LABEL

0001             NO TO CANCEL

XXXX                    ABC
-

PERS.CODE     CONF.ID SETTING

0001             

CONF.ID:           YES TO END
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Input a 4-digit Confidential

ID if you wish to use this

feature (you can skip this

step if you wish).

Press Yes.

Use a Quick Dial or Speed

Dial to specify the routing

address.

❐ If you specify a Quick Dial or Speed Dial that does not have a

mail address assigned to it, the message UNABLE TO PRO-

GRAM appears.

❐ Note that you cannot input a routing address manually.

Press Yes.

Press Function.

PERS. CODE      PRES QCK/SPD

0001 XXXX

Mail To:         NO TO CANCEL
-

PERS. CODE     YES OR NO

0001 XXXX

16  abc@abc.comany.com

PERS. CODE     ENTER ID CODE

             PRINT LIST →
-

NO TO CANCEL

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%

PERS.CODE      YES OR CLR • NO

0001 ABC             

CONF.ID: 1234           
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EDITING A PER-
SONAL CODE

To change a Personal Code, you must delete the existing code and

program a new one from the beginning. Use the following procedure

when you want to change the name or routing address.

Press Function 60.

❐ If a previous function screen is already shown, you need to

press No followed by 6 then 0 instead.

❐ See page 4 of the main Operator’s Manual for details on the

sequence that functions are displayed.

Press 222271.

❐ While this screen is on the display, you can print a Personal

Code list by pressing 3 and then Start. See page 92 of this

Operator’s Manual for details on the Personal Code List.

Use the Ten-Key Pad to

input the four-digit Per-

sonal Code whose name

and routing address you

want to edit.

❐ If you make a mistake during input, press No and input again.

Press Yes.

If you want to change the

Quick Dial to which the

Personal Code is assigned,

press No.

❐ If you don’t want to change the Quick Dial, Skip to step 7.

SYSTEM SET

NO TO CANCEL
-

PERS. CODE     ENTER ID CODE

NO TO CANCEL
-

PRINT LIST →

PERS. CODE     YES OR NO

0001 XXXX

        CLR: CLR

PERS. CODE     YES OR NO

0001 XXXX

16  

PERS. CODE    CHOOSE KEY

0001

YES TO SKIP NO TO CANCEL
-
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USING FUNCTIONS

Press the Quick Dial key to

which you want to change.

Press Yes.

Use Clear or No then

change the name.

❐ If you do not want to change the name, skip to step 9.

Press Yes.

If you wish, enter a Confiden-

tial ID and press No. To skip

this step, just press Yes.

Use a Quick Dial or Speed

Dial to change the routing

address.

Press Yes.

Press Function.

Deleting a Personal Code

See page 77 of the main Operator’s Manual for details on deleting

Personal Codes.

PERS. CODE     YES OR NO

0001 XXXX

17  

PERS. CODE     ENTER LABEL

0001             NO TO CANCEL

XXXX                     ABC
-

PERS. CODE     ENTER LABEL

0001             NO TO CANCEL

XXXX                    ABC
-

PERS. CODE     ENTER LABEL

0001             NO TO CANCEL

                        ABC

PERS. CODE    CONF.ID SETTING

0001 XXXX

CONF.ID:           YES TO END

PERS. CODE     YES OR NO

0001 XXXX

01  ccc@abc.comany.com

PERS. CODE     ENTER ID CODE

             PRINT LIST →
-

NO TO CANCEL

MEMORY TRANS.        24.SEP. 15:00

SET DOC. OR ENTER FAX NO.

                  MEMORY100%
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IC FAX Monitor

STARTING UP
AND QUITTING
IC FAX Monitor

Starting up IC FAX Monitor

❐ The following procedure describes operation in the User Mode.

Start up the computer on which IC FAX Monitor is already

installed.

On the [Start] menu, point to [Programs] and then [IC FAX

Applications]. Next, click [IC FAX Monitor].

Type the IP address or host name into the [Host Name] text

box, and then click [OK].

❐ Clicking the ∞ button displays a list of up to five previously

connected IP addresses or host names.

❐ Note that this dialog box does not appear if you have already

specified an IP address or host name. Instead, IC FAX Monitor

automatically connects to the last IC FAX to which it was

connected.

❐ Contact your network administrator if you are unsure of the IP

address or host name to input here.
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IC FAX Monitor

After a few moments, the initial IC FAX Monitor screen

shown here appears.

❐ Activation of the computer’s power save function can cause

the connection with the IC FAX to be broken.

Quitting IC FAX Monitor

From the initial IC FAX Monitor screen, click the [Connect] menu’s

[Exit] command.

❐ Perform the following procedure to restart IC FAX Monitor. On the

[Start] menu, point to [Programs] and then [IC FAX Applications].

Next, click [IC FAX Monitor].
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SPECIFYING THE
TARGET FAX

Use the following procedure to switch between fax machines when

there are more than one NIC FAX machines on the network.

From the initial IC FAX Monitor screen, click the [Connect]

menu’s [Connect to FAX] command.

Type in the IP address or host name of the NIC FAX to which

you want to connect, and then click [OK].

❐ Clicking the ∞ button displays a list of up to five previously

connected IP addresses or host names.

[OK]
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IC FAX Monitor
INITIAL SCREEN

The initial screen shown below appears whenever you start up IC

FAX Monitor. It shows the FAX that is currently selected, along with

the status of a variety of different settings.

❐ Activation of the computer’s power save function can cause the

connection with the NIC FAX to be broken.

1 Network connection status

This area shows the communication status while IC FAX communi-

cation is in progress.

2 Error status message

See Troubleshooting on page 168 of this Operator’s Manual for

details on error status messages.

3 Fax machine memory status

Remaining memory is shown as a percent and bar graphic.

4 Received document

This indicator appears to indicate a received file (confidential

reception, substitute reception, authorized reception) in memory.

5 IP address or host name of connected NIC FAX

6 Current connection mode

1

5
2

3

4

6
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CHANGING THE
CONNECTION
MODE

Use the following procedure to switch IC FAX Monitor between its

User Mode and Administrator Mode.

Changing from the User Mode to the Administrator Mode

From the initial IC FAX Monitor screen, click the [Connect]

menu’s [Administrator Mode] command.

Type in the password.

Click [OK].

❐ The message “<BUSY! PC COMMUNICATING>” is shown on

the display if connected to IC FAX Monitor. Also, IC FAX

functions 20 through 40 and functions normally made avail-

able by input of the password 2222 are all disabled.

❐ Attempting to enter the Administrator Mode while any function

in the range of 20 through 40, or a function made available by

input of the password 2222 causes the message “<Sorry, busy

for doing some other tasks>” to appear in the IC FAX Monitor

screen. IC Fax Monitor will not enter the Administrator Mode

when this message appears.

❐ Failure to perform any input for 10 minutes in the Administra-

tor Mode causes an error. Next, IC FAX Monitor returns auto-

matically to the User Mode.

❐ See page 62 of this Operator’s Manual for details about set-

ting the Administrator Mode password.

[OK]

[Password]
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Changing from the Administrator Mode to the User Mode

From the initial IC FAX Monitor screen, click the [Connect] menu’s

[User Mode] command.

❐ The User Mode can be used to view current settings.
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MEMORY STATUS Use the following procedures to view IC FAX memory status, as well

as lists of send documents, receive documents, and Auto Documents.

From the initial IC FAX Monitor screen, click the [Memory Status] button.

❐ IC FAX Monitor gets the most recent data from NIC FAX and

displays it in the dialog box.

❐ Clicking the [Refresh] button at the bottom of the dialog box gets

the latest data from NIC FAX and updates the data on the dialog

box.

[Refresh]
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Viewing Files Awaiting Transmission

Click the [Transmission] tab.

❐ Clicking any of the column names at the top of the data sorts

the files in the list according to the data whose column name

you clicked.

❐ Up to 100 files can be shown at one time.

❐ The [Page] column of the [Transmission] tab shows the

number of pages.

[Details]
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IC FAX Monitor

To view the details of a particular file, click on its name and

then click the [Details] button.

❐ The dialog box that appears shows all other destinations (if

any), personal code, and other information.
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Viewing Files That Have Been Received Into Fax Memory

Click the [Reception] tab.

❐ This tab shows all the received files in memory.

❐ Clicking any of the column names at the top of the data sorts

the files in the list according to the data whose column name

you clicked.

[Reception]
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Viewing Auto Documents

Click the [Auto Document] tab.

❐ This tab shows all the Auto Document files in memory.

❐ See page 68 of the main Operator’s Manual for details about

Auto Documents.

[Auto
Document]
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JOURNALS
(TRANSMISSION
AND RECEPTION)

Viewing the Send and Reception Journals

From the initial IC FAX Monitor screen, click the [Display

Journal] button.

❐ IC FAX Monitor gets the most recent data from NIC FAX it in

the dialog box.

Click the [Transmission] or [Reception] tabs to view the

applicable data.

 Note

Note
• Up to 100 entries can be shown

in each journal.

• Clicking any of the column

names at the top of the data

sorts the files in the journal

according to the data whose

column name you clicked.

[Transmission]
or
[Reception]

[Print]
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ADDRESS BOOK
(QUICK DIAL,
SPEED DIAL,
GROUP DIAL)

You can use the Address Book to add Quick Dials, Speed Dials, and

Group Dials to IC FAX memory. Note that this operation must be

performed in the IC FAX Monitor Administrator Mode.

❐ You can program a mail address or fax number to a Quick Dial for

input with the touch of a key. Quick Dial code numbers correspond

to the numbers shown on the IC FAX Quick Dial keys.

❐ Clicking [Addresses] in the User Mode displays Address Book

data, but you cannot make any changes while in this mode.

Adding a New Quick Dial

❐ Note that you can use IC FAX Monitor to add Quick Dials. You can

also IC FAX control panel when you want to edit or delete Quick

Dials.

From the initial screen in the Administrator Mode, click the

[Addresses] button.
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Click the [Quick Dial] tab.

Click the [Add] button.

Click the ∞ button to the right of the [Quick Dial Key] text

box, and select a number from the list that appears.

❐ Currently unused Quick Dial numbers only are shown in the

list. The list can show up to 64 numbers.

Click the ∞ button to the right of the [Address Type] text box,

and select the number type from the list that appears.

❐ You can specify that the destination is either a fax number or

mail address. In the case of FAX Number, you can also set the

dial options on the right side of the dialog box.

[Quick Dial]

[Print]

[Add]
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IC FAX Monitor

Type the destination mail address or fax number  into the

[Address] text box.

Type the name of the destination into the [Label] text box.

Click on a radio button to turn [Label Insertion] on or off.

❐ Turning label insertion on automatically inserts and sends the

destination name you specify in step 7.

Click [OK] after you are finished making the settings you

want.

❐ In the case of a confidential transmission or polling transmis-

sion, type in the dial options described below before you click

[OK].

❐ You can also edit or delete Quick Dial by IC FAX Monitor (But,

as for Programming Keystrokes or Storing an Auto Document,

it can’t be done.).

Dialling with the Dial Option Key

The four dial option settings on the right side of the dialog box be-

come enabled when [FAX Number] is selected for [Address Type].

These options can be used for confidential transmission and polling

reception from a fax machine that is equipped with these functions.

■ SUB

Type in the SUB (confidential ID number) when the destination you

are adding requires one for confidential transmission. When the

destination is a NIC FAX, this can be used as a routing address

specification, but note that confidential transmission is not available

for a routed document.

■ SEP

Type in the SEP (polling ID number) used by the destination for re-

ceiving faxes by polling.
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■ PWD

Type in the PWD (polling password) for receiving faxes by polling in

combination with SEP above. This setting is not required when the

other machine is a NIC FAX.

■ SID

Type in the SID (confidential password) for confidential transmission

in combination with the SUB code above. This setting is not required

when your machine is a NIC FAX.

 NoteNote
• Dial options can have up to 20

digits, each of which is a

number (0 to 9), pound sign (#),

or asterisk (*).
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Adding a New Speed Dial

❐ Note that you can use IC FAX Monitor to add Speed Dials. You can

also NIC FAX operation panel when you want to edit or delete

Speed Dials.

From the initial screen in the Administrator Mode, click the

[Addresses] button.

[Speed Dials]

[Add]

Click the [Speed Dials] tab.
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Click the ∞ button next to the [Display Range] text box and

select the range of Speed Dials you want to display.

❐ Clicking ∞ displays a list of 10 different ranges for Speed Dials

000 through 999.

❐ Speed dials 100 through 999 are available when an optional

FUNCTION UPGRADE CARD TYPE140 is installed.

❐ An error occurs when the Speed Dial you specify in the next

step is not within the range you specify here. This means that

if you plan to specify Speed Dial 100, you should select the

range [100-199] here.

Click the [Add] button.

❐ The [Add] button is dimmed if all the Speed Dials are already

used.

Type the number of the Speed Dial you want to add into the

[Speed Dial] text box.

❐ Specify a number from 000 to 099 with the normal configuration.

When an optional FUNCTION UPGRADE CARD TYPE140 is

installed, you can specify a number from 000 to 999.

Click the ∞ button to the right of the [Type] text box, and

select the number type from the list that appears.

❐ You can specify that the destination is either a fax number or

mail address.
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Type the destination mail address or fax number  into the

[Address] text box.

Type the name of the destination into the [Label] text box.

Click on a radio button to turn [Label Insertion] on or off.

❐ Turning label insertion on automatically inserts and sends the

destination name you specify in step 7.

Type one character into the [Search] text box.

❐ This character is searched by the IC FAX telephone directory

for destination searches.

❐ You can specify any alphabetic character as the search char-

acter.

Click [OK] after you are finished making the settings you

want.

❐ In the case of a confidential transmission or polling transmis-

sion, type in the dial options described below before you click

[OK]. See page 131 of this Operator’s Manual for details on

how to input Dial Options.

❐ You can also edit or delete Quick Dial by IC FAX Monitor (But,

as for Programming Keystrokes or Storing an Auto Document,

it can’t be done.).
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Adding a New Group Dial

❐ Note that you can use IC FAX Monitor to add Group Dials. You can also

NIC FAX operation panel when you want to edit or delete Group Dials.

From the initial screen in the Administrator Mode, click the

[Addresses] button.
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Click the [Groups] tab.

❐ See page 171 of the main Operator’s Manual for full details on

the contents of the Group Dial List.

❐ You can also edit or delete Quick Dial by IC FAX Monitor (But,

as for Programming Keystrokes or Storing an Auto Document,

it can’t be done.).

Click the [Add] button.

❐ The [Add] button is dimmed if all the Group Dials are already used.

[Groups]

[Add]

[Group Number]
[Assigned Quick
Dial]

[Group Name]

[OK]
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Click the ∞ button to the right of the [Group Number] text

box, and select a number from the list that appears.

❐ Currently unused Group Dial numbers only are shown in the list.

❐ You can program up to nine groups with the normal configura-

tion. When an optional FUNCTION UPGRADE CARD

TYPE140 is installed, you can specify up to 30 groups.

Click the ∞ button to the right of the [Assigned Quick Dial]

text box, and select the setting you want from the list of

options that appears.

❐ If you don’t want to assign the group to a Quick Dial key, select

[none] to which you want to assign the group. To assign the

group to a Quick Dial key, select the key’s number from the list.

Type up to 20 characters for the name you want to give the

group into the [Group Name] text box. Add destinations

addresses to this Group.

Add destination addresses to this Group.

❐ You can add or delete destinations, or add destinations as-

signed to Quick Dials and Speed Dials.

❐ To add a destination assigned to a Quick Dial or Speed Dial,

select either [Quick Dial] or [Speed Dial] from the drop-down

list on the right, click on the item you want to add in the list

below, and then click the [Add] button.

❐ To delete a destination, click on it in the list on the left, and

then click the [Delete] button.

Click [OK] after you are finished making the settings you

want.

 Note

Note
• You can program up to 200

destinations, including Quick

Dials, Speed Dials, and destina-

tions input individually with the

Ten-Key Pad. With IC FAX

Monitor, however, you cannot

use the Ten-Key Pad to input a

destination.

• The total number of destina-

tions that can be programmed

for all groups is 264: 64 Quick

Dials, 100 Speed dials, and 100

Ten-Key Pad inputs. When an

optional FUNCTION UP-

GRADE CARD TYPE140 is

installed, the number of Speed

Dials is increased by 1,000, for

a total of 2,064 destinations.
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You can use IC FAX Monitor to add Multi-Step Transfer Groups,

transfer stations, and end receivers. Note that this operation must be

performed in the IC FAX Monitor Administrator Mode.

❐ Contact your service representative for details.

❐ Note that you can use IC FAX Monitor to add Multi-Step Transfer

Groups. You can also NIC FAX operation panel when you want to

edit or delete them.

ADDING MULTI-
STEP TRANS-
FER GROUPS

G3 Fax - 1

G3 Fax - 2

NIC FAX 1

NIC FAX 2

Internet

Telephone 
Network

Telephone 
Network

Transfer Station 1

Transfer Requester

Transfer Station 2
End Receiver
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From the Details menu of IC FAX Monitor, click the [Multi-

step Transfer Group Settings] command.

Click [Add].

❐ The [Add] button is dimmed if all the Multi-Step Transfer

Groups are already used.

[Add]

[Group Number]

[Group Name]

[Add]

[OK]

[Transfer Sta-
tion Settings]

[End Receiver
Settings]
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Click the ∞ button to the right of the [Group Number] text

box, and select a number from the list that appears.

❐ Currently unused Multi-Step Transfer Group numbers only are

shown in the list.

❐ You cannot select a number that is already used.

Type up to 20 characters for the name you want to assign to

the Multi-Step Transfer Group into the [Group Name] text

box.

Make the Transfer Station Settings you want.

❐ These are settings for the transfer requester fax machine. The

destination can be specified from those assigned to Quick

Dials or Speed Dials.

❐ The specified fax becomes the transfer station, which sends

the document to each of the fax machines specified as end

receivers.

Make the End Receiver Settings you want.

❐ These are the settings for the destination of the transmission

from the transfer station.

❐ These settings are made in accordance with the transfer

station’s Quick Dials, Speed Dials, and Group Dials, so infor-

mation about these dials are required before these settings

can be made.

❐ To make this setting, select Quick Dial, Speed Dial, or Group

Dial, and then input the number you want to set.

Click [Add].

Click [OK] after you are finished making the settings you

want.

❐ You can also edit or delete Quick Dial by IC FAX Monitor.
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ADDING
PERSONAL
CODES

You can use IC FAX Monitor to add Personal Codes. Note that this

operation must be performed in the IC FAX Monitor Administrator Mode.

❐ Note that you can use IC FAX Monitor to add Quick Dials. You can

also NIC FAX operation panel when you want to edit or delete

Personal Codes.

Enter the Administrator Mode.

❐ See page 121 of this Operator’s Manual for details on entering

the Administrator Mode.

On the [Details] menu, click [Personal Codes].

[Add]
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Click the [Add] button.

❐ Four-digit Personal Codes (SUB) appended to faxes sent from

G3 machines are compared with Personal Codes pro-

grammed on the NIC FAX. A matching code causes the fax to

be routed to the destination assigned to the Personal Code.

❐ The [Add] button is dimmed if all the Personal Codes are

already used.

❐ You can program up to 50 Personal Codes with the normal

configuration. When an optional FUNCTION UPGRADE

CARD TYPE140 is installed, you can specify up to 500 Per-

sonal Codes.

[OK]

[Personal Code]

[Name]

[Assigned Quick
Dial]

[Quick Dial or
Speed Dial]
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IC FAX Monitor

Type a Personal Code number into the [Personal Code] text

box.

❐ You can input any four-digit code except 0000. A number can

be used only once.

Type up to 20 characters for the name you want to give the

Personal Code into the [Name] text box.

Click the ∞ button to the right of the [Assigned Quick Dial]

text box, and select a number from the list that appears.

❐ Use this setting to specify whether or not you want to assign

the Personal Code to a Quick Dial. If you do, select one of the

Quick Dial numbers from the list.

If you did not assign the Personal Code to a Quick Dial

number with the previous step, make the [Routing Address

Setting].

❐ Click the ∞ button next to the text box on the left, and then

select either Quick Dial or Speed Dial from the list that ap-

pears.

❐ When the contents of the Quick Dial or Speed Dial appear in

the list on the right, click on the mail address you want.

❐ The selected mail address appears in the [Routing Address]

box. Fax numbers are not shown.

Click [OK] after you are finished making the settings you

want.

❐ The destination (mail address) is specified automatically when

a transmission with an SUB appended by the sender arrives.

The routing addresses are selected from mail addresses

assigned to Quick Dials and Speed Dials.

❐ You can also edit or delete Quick Dial by IC FAX Monitor.
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IC FAX Monitor

ADDING
FORWARDING
STATION
ADDRESSES

You can use IC FAX Monitor to add forwarding station addresses.

Note that this operation must be performed in the IC FAX Monitor

Administrator Mode.

❐ Note that you can use IC FAX Monitor to add forwarding station

addresses. You can also NIC FAX operation panel when you want

to edit or delete them.

Enter the Administrator Mode.

On the [Details] menu, click [Forwarding].

[Add]
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IC FAX Monitor

Click the [Add] button.

❐ Four-digit function codes (SUB) appended to faxes sent from

G3 machines are compared with Personal Codes pro-

grammed on the NIC FAX. A matching code causes the fax to

be routed to the destination assigned to the Personal Code.

❐ Up to five forwarding station addresses can be programmed.

The [Add] button is dimmed if all five forwarding station ad-

dresses are already used.

Click the ∞ button to the right of the [Forwarding No.] selec-

tor, and select a number from the list that appears.

❐ Currently unused forwarding station address numbers only are

shown in the list.

Click the ∞ button to the right of the [Type] text box, and

select the number type from the list that appears.

❐ You can specify that the destination is either a fax number or

mail address. In the case of FAX Number, you can also set the

dial options in the lower left of the dialog box.

[Add]

[Delete]

[OK]
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IC FAX Monitor

Type in the fax number or mail address into the [Address]

text box.

❐ You can input up to 254 characters, including dial options, for

a fax number. Each character can be a number (0 to 9), pound

sign (#), asterisk (* ), or hyphen (−).

❐ You can input up to 127 alphabetic characters for a mail address.

❐ See page 131 of this Operator’s Manual for details on dial options.

Specify the dial options.

Add any destinations you want to use as specified senders.

❐ Program specified senders when you want to forward only

faxes from specified senders or perform other operations only

for messages from certain senders.

❐ Type in the RTI or CSI of the specified sender. To delete a

specified sender, click on its name to select it and then click

the [Delete] button. After deletion is complete, click [OK] and

jump to step 10.

❐ You can program up to 30 specified senders with the normal

configuration. When an optional FUNCTION UPGRADE

CARD TYPE140 is installed, you can specify up to 50 speci-

fied senders.

❐ The [Add] button is dimmed if no more specified senders can

be added.

Turn Wild Cards on or off. Then click [Add].

❐ Turning on Wild Cards causes all faxes that contain the speci-

fied user name in the RTI or CSI to be forwarded.

Click [OK] after you are finished making the settings you want.

❐ The [Specified Senders Details] list shows specified sender

names, and whether wild cards are on or off.

❐ You can also edit or delete Quick Dial by IC FAX Monitor.
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IC FAX Monitor

EDITING
FORWARDING
SETTINGS

Use the procedure below to edit forwarding settings.

Enter the Administrator Mode.

❐ See page 122 of this Operator’s Manual for details on entering

the Administrator Mode.

On the [Details] menu, click [Forwarding].

Click the [Edit Options] button.

Click on a radio button to turn forwarding on or off.

❐ Forwarding should be turned on after the forwarding station

and specified senders are programmed.

[Edit options]

[OK]

[Print For-
warding Mark]

[Forwarding]

[Forwarding
Station]



USING FUNCTIONS

IC FAX Com 
Redirector

TROUBLESHOOTING

APPENDIX

GLOSSARY

INTERNET FAXING

GETTING READY

GETTING AQUAINTED
WITH NIC FAX

IC FAX Monitor

Contents

Index

149

IC FAX Monitor

Click on a radio button to select the forwarding station.

❐ This setting specifies whether only documents received from

specified senders or documents received from senders other

than specified senders should be forwarded.

Click on the checkbox to turn forwarding mark printing on

(checked) or off (unchecked).

❐ This setting determines whether or not forwarding marks are

printed on faxes when they are forwarded. The forwarding

mark helps to distinguish forwarded faxes from standard

faxes.

Click [OK] after you are finished making the settings you

want.
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IC FAX Monitor

VIEWING FAX
INFORMATION

Use this procedure when you want to check such information as TTI,

RTI, CSI, and Own Number. These settings are made using the

operation panel of the NIC FAX.

Enter the User Mode or Administrator Mode.

From the initial IC FAX Monitor screen, click [Setup] from the

[Settings] Menu.

❐ This displays the [Setup] dialog box.

Click the [Fax] tab.

[FAX]

[OK]
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After you are finished, click [OK].

■ TTI

The Transmitter Terminal Identification is a preprogrammed name that

is printed on the pages of the sender’s document. The TTI is best

used for the company name, branch name, etc.

■ RTI

The Receive Terminal Identification is data that is sent between

machines during send and receive operations. This data appears on

the display of the machine being communicated with and is printed in

reports.

■ CSI

The Called Station Identification is data that is sent between ma-

chines during send and receive operations. This data appears on the

display of the machine being communicated with and is printed in

reports. The CSI is sent and received even when the other party is not

a fax machine.

The normal format for the CSI is: country code, local area code,

number.

■ Own Number (G3)

This is the number that is called to connect with the fax machine.
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IC FAX Monitor

USING ONLINE
HELP

Online help gives you instant access to useful information about IC

FAX Monitor on your computer screen.

From the initial IC FAX Monitor screen, click the [Help] menu’s [Help

Topics] command to display the help dialog box.

Using Index Search

Use the following procedure to search for a help topic from the index.

In the [Help Topics: IC FAX Monitor Help] dialog box, click

the [Contents] tab.

Click on a <book> icon to select it, and then click the [Open]

button.

[Open]
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IC FAX Monitor

Click on the topic about which you want more information,

and the click the [Display] button.

❐ If your computer is connected to a printer, you can print the

currently displayed help screen by clicking the [Print] button.

[Display]
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[Display]

Using Keyword Search

Use the following procedure to search for a help topic by keyword.

In the [Help Topics: IC FAX Monitor Help] dialog box, click

the [Index] tab.

Input a number of characters for the topic for which you

want to search and then click the [Display] button. You can

also scroll through the list to find the topic you want, click

on it, and then click the [Display] button.
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[OK]

Displaying Version Information

On the [Help] menu, click [About...] to display a dialog box

that shows version information about IC FAX Monitor.

Click [OK] to close the dialog box.
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STARTING UP
AND QUITTING
IC FAX Com
Redirector

Starting Up IC FAX Com Redirector

Turn on your computer and start up Windows 95.

❐ This automatically launches IC FAX Com Redirector and

displays its icon in the Task Bar.

❐ Double-clicking the IC FAX Com Redirector icon displays the

setup screen, which shows the host and Personal Code you

programmed when installing the IC FAX applications (step 33

on page 46 of this Operator’s Manual).

Click [Test Connection] to check the fax connection.

 Note

[Test Connection]

Note
• The dialog box that appears in

step 2 of the right procedure

does not appear on subsequent

Windows 95 startups if you put

a check in the checkbox next to

“<Do Not Show This Display

At Startup>.” In such a case,

you have to open the dialog box

manually by double-clicking the

IC FAX Com Redirector icon in

the Task Bar.
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The dialog box shown below appears when a fax machine is

connected to the computer (an error occurs when no fax

machine is connected). Click [OK] to close this dialog box.

❐ An IC FAX Com Redirector icon is in the Task Bar while IC

FAX Com Redirector is running. This icon changes form as

shown in the table below to keep  you informed of the commu-

nication status.

Icon Status

Normal communication enabled. Standing by

connection.

Fax is performing a communication operation.

Fax communication is disabled. Check settings

and setup.

[OK]
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Quitting IC FAX Com Redirector

Right click the [IC FAX Com Redirector] on the Task Bar.

This opens a menu.

On the menu, click [Exit].

This displays a confirmation message.

Click [OK].

❐ This quick IC FAX Com Redirector and clears its icon from the

Task Bar.

❐ The PC fax function is disabled when IC FAX Com Redirector

is not running.

Perform the following procedure to restart IC FAX Com

Redirector. On the [Start] menu, point to [Programs] and then

[IC FAX applications]. Next, click [IC FAX Com Redirector].

[Exit]

[OK]
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Displaying Version Information

Right click the [IC FAX Com Redirector] on the Task Bar.

This opens a menu.

On the menu, click [About] to display a dialog box that

shows version information about IC FAX Com Redirector.

Click [OK] to close the dialog box.

[OK]
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USING ONLINE
HELP

Online help gives you instant access to useful information about IC

FAX Com Redirector on your computer screen.

From the initial IC FAX Com Redirector setting screen (page

157), click the [Help] button, or right click the IC FAX Com

Redirector task bar icon and then click [Help] on the menu

that appears.

❐ This displays the online help window. You can find the informa-

tion you want using index search or keyword search.

Help window when the [Help] button is clicked on the initial IC

FAX Com Redirector screen.

[Contents]
tab

[Index] tab



USING FUNCTIONS

IC FAX Com 
Redirector

TROUBLESHOOTING

APPENDIX

GLOSSARY

INTERNET FAXING

GETTING READY

GETTING AQUAINTED
WITH NIC FAX

IC FAX Monitor

Contents

Index

162

IC FAX Com Redirector

[Contents]
tab

[Index] tab

❐ Clicking red or green underlined text displays the correspond-

ing help text.

Help window when the [Help] button is clicked on the IC FAX Com

Redirector task bar icon.
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Using Index Search

In the help window, click the [Contents] tab.

Click on the topic you want help on, and then click the [Dis-

play] button.

❐ If your computer is connected to a printer, you can print the

currently displayed help screen by clicking the [Print] button.

[Display]
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[Display]

Enter a word
you are
looking for

Using Keyword Search

In the help window, click the [Index] tab.

Input a number of characters for the topic for which you

want to search and then click the [Display] button.
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ERROR
MESSAGES

NIC FAX Display Messages

The following error messages appear on the display of the NIC FAX

when a problem occurs. If the advice provided below does not solve

the problem, contact your service representative.

        Message     Causes and Recommended Actions

Network Error  [10-40] • No fax IP address is set. Use the NIC FAX
control panel to set an IP address. (Page 26)

• Call your network administrator.

Network Error  [10-41] • Multiple IP addresses. Use the NIC FAX control
panel to check that the IP address is correct.
(Page 26)

• Call your network administrator.

Network Error  [10-61] • POP server cannot be found. Use IC FAX
Monitor to check whether the POP server’s IP
address is correct. (Page 56)

• Call your network administrator.

Network Error  [10-62] • Cannot log into the POP server. Use IC FAX
Monitor to check whether login name and
password are correct.

• Call your network administrator. (Page 56)

Network Error  [10-70] • No SMTP server IP address is set. Use IC FAX
Monitor to register an SMTP server. (Page 56)

• Call your network administrator.

Network Error [10-73] • SMTP server cannot be found. Use IC FAX
Monitor to check whether the SMTP server’s IP
address is correct. (Page 56)

• Call your network administrator.

Network Error [10-74] • No mail address is set for the fax machine. Use
IC FAX Monitor to set a mail address. (Page 56)

• Call your network administrator.

Network Error  [10-50] • A line error occurred during receipt of data.
 [10-63] Make sure the LAN cable is correctly connected
 [10-82] to the fax machine. (Page 24)

• Call your network administrator.
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Network Error  [10-30] • Mechanical malfunction has occurred. Contact
 [10-31] your service  representative.
 [10-33]
 [10-34]
 [10-35]
 [10-42]

BUSY! This message appears on the display of the fax
machine

PC COMMUNICATING while it is connected to the IC FAX Monitor
Administrator Mode. At this time control panel
Functions 20 through 40 and functions
accessed with password 2222 are disabled.

        Message     Causes and Recommended Actions
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IC FAX Monitor Initial Screen Messages

The following is a list of messages that appear in the initial screen of

IC FAX Monitor and actions you should take when they appear.

Icon        Message    Causes and Recommended Actions

• Contact your service representative.

• LAN network error

• G3 communication error. See page 210

of the main Operator’s Manual.

• NIC FAX cover is open. Close the cover.

• Copy jam. Clear the jam. See page 203

of the main Operator’s Manual.

• Document jam. Clear the jam. See page

201 of the main Operator’s Manual.

• Out of paper. Load paper. See page 176

of the main Operator’s Manual.

• Install the toner cartridge correctly. See

page 182 of the main Operator’s Manual.

• Out of toner. Replace the toner cartridge

with a new one. See page 182 of the

main Operator’s Manual.

• Low toner. Replace the toner cartridge

with a new one soon. See page 182 of

the main Operator’s Manual.

Please call a

service engineer

Network error

Communication

error

Close the cover

Clear copy

Clear original

Load paper

Set the toner

cartridge properly

Replace the toner

cartridge

Toner near empty
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IC FAX Monitor Operation Messages

           Message Causes and Recommended Actions

• The specified IP address is not entered cor-
rectly. Make sure the NIC FAX IP address you
got from your network administrator is correct. It
should be made up of four numbers from 0 to
255, separated by periods. (Page 26)

• The specified access control is not entered
correctly. Make sure access control is correct. It
should be make up of four numbers from 0 to
255, separated by periods. (Page 58)

• The specified access mask is not entered
correctly. Make sure the NIC FAX access mask
is correct. It should be made up of four numbers
from 0 to 255, separated by periods. (Page 58)

• The specified gateway is not entered correctly.
Make sure the gateway (router) address is
correct. The gateway should be made up of four
numbers from 0 to 255, separated by periods.
(Page 26)

• The specified subnet mask is not entered
correctly. Make sure the NIC FAX subnet mask
you got from your network administrator is
correct. It should be made up of four numbers
from 0 to 255, separated by periods. (Page 26)

• The specified POP server IP address is not
entered correctly. Make sure the IP address of
the POP server being used by NIC FAX is
entered correctly. (Page 56)

• The specified SMTP server IP address is not
entered correctly. Make sure the IP address of
the SMTP server being used by NIC FAX is
entered correctly. (Page 56)

The IP address is
incorrect in the TCP/IP
settings.

The access control IP
address is incorrect  in
the TCP/IP settings.

The access control
mask is incorrect in the
TCP/IP settings.

The default gateway IP
address is incorrect in
the TCP/IP settings.

The subnet mask is
incorrect in the TCP/IP
settings.

The POP server IP
address is incorrect in
the Mail settings.

The SMTP server IP
address is incorrect in

the Mail settings.
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• IC FAX Monitor is automatically returning to the
User Mode after being left in the Administrator
Mode for 10 minutes without any input. Re-enter
the Administrator Mode if you need to make
more settings. (Page 122)

• The specified address is too long and cannot be
stored. Up to 254 characters, including dial
options, can be input for a fax number.

• A network error occurred while getting data from
the NIC FAX address table. Check the following
points, reconnect, and try again.

• Confirm that NIC FAX is turned on.
• Confirm that the LAN cable is correctly con-

nected to NIC FAX. (Page 24)
• Check whether NIC FAX network settings have

been changed. (Page 56)

• Maintenance procedure is being performed by
service personnel. Wait until maintenance is
finished.

• Problem with the Windows system. Restart your
computer.

• Problem with the Windows system. Restart your
computer.

• A network error occurred while getting NIC FAX
status data. Check the following points, recon-
nect, and try again.

• Confirm that the LAN cable is correctly con-
nected to NIC FAX. (Page 24)

• Check whether NIC FAX network settings have
been changed. (Page 56)

• NIC FAX is busy. Wait a while and try again.

[Administrator Mode
Monitor Error]
No input for 10 minutes
so returning to User
mode.

Address is too long.

[Application Error]
Stopped due to an
error when retrieving
Address Book data.

[FAX command error]
Sorry, not executable at
the moment.

[Application Error]
System error.

[Application Error]
System timer reset
failure.

[Network Error]
Failed to initialize the
status.

[ FAX command error]
Timeout occurred.

           Message Causes and Recommended Actions
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• The password you input does not match the
password registered on NIC FAX. Input the
correct password.

• The backup file you specified does not exist or
is corrupted.
Specify a valid backup file. (Page 64)

• A network error occurred while getting NIC FAX
memory status data. Check the following points,
reconnect, and try again.

• Confirm that NIC FAX is turned on.
• Confirm that the LAN cable is correctly con-

nected to NIC FAX. (Page 24)
• Check whether NIC FAX network settings have

been changed. (Page 56)

• No file name specified for a backing up or
restoring memory data. Specify a file name.
(Page 63)

• A network error occurred during communication
with NIC FAX. Check the following points,
reconnect, and try again.

• Confirm that NIC FAX is turned on.
• Confirm that the LAN cable is correctly con-

nected to NIC FAX. (Page 24)
• Check whether NIC FAX network settings have

been changed. (Page 56)

• The Windows print font is not installed. Install
MS Gothic.

           Message Causes and Recommended Actions

[Application Error]
The password you
entered is incorrect.
Please try again.

[Application Error]
An I/O error occurred
during the backup.

[Application Error]
Stopped due to an
error while retrieving
file list.

Please specify a
filename.

[Network error]
Error when connecting
to FAX.

[Application Error]
Failed while making
fonts for pre-print
processing.
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• The command you are trying to use cannot be
processed by NIC FAX. Check that you are
inputting the command correctly.

• The connected fax machine is not supported by
this version of NIC FAX Monitor. Install the
correct version of software.

• The command you are trying to use cannot be
processed by NIC FAX. Check that you are
inputting the command correctly.

• The connected fax machine is not supported by
this version of NIC FAX Monitor. Install the
correct version of software.

• The backup file you specified is not a NIC FAX
restoring memory data. Specify a proper backup
file. (Page 64)

• The backup file you specified is not a backup
file. Specify a proper backup file. (Page 64)

• Confirm that the NIC FAX host name or IP
address is set correctly. (Pages 56~58)

• Confirm that NIC FAX is turned on.
• Confirm that the LAN cable is correctly con-

nected to NIC FAX. (Page 24)
• Confirm that the IP address and subnet mask

are set correctly on NIC FAX. (Page 26)
• Confirm that TCP/IP protocols are installed on

the computer where IC FAX Monitor is installed.
• Confirm that the DNS (Domain Name Server)

settings on the computer where IC FAX Monitor
is installed are correct.

• Confirm that NIC FAX is registered on the DNS.
• When NIC FAX is not on the same network,

confirm that the settings of the computer where
IC FAX Monitor is installed and those  on the
NIC FAX gateway are correct. (Page 58)

• Contact your net work administrator.
• The Saving energy mode on the computer is

activated. Turn off the Energy Saving mode.

[FAX command error]
Bad command.

[FAX command error]
Bad parameter.

[Application Error]
Cannot restore using the
specified backup file.

[Application Error]
You entered an invalid
backup file.

[Network error]
Could not connect to
specified host.

           Message Causes and Recommended Actions



USING FUNCTIONS

IC FAX Com 
Redirector

TROUBLESHOOTING

APPENDIX

GLOSSARY

INTERNET FAXING

GETTING READY

GETTING AQUAINTED
WITH NIC FAX

IC FAX Monitor

Contents

Index

173

TROUBLESHOOTING

• Confirm that the NIC FAX host name or IP
address is set correctly. (Pages 56, 58)

• Confirm that NIC FAX is turned on.
• Confirm that the LAN cable is correctly con-

nected to NIC FAX. (Page 24)
• Confirm that the IP address and subnet mask

are set correctly on NIC FAX. (Page 26)
• Confirm that the DNS (Domain Name Server)

settings on the computer where IC FAX Monitor
is installed are correct.

• Contact your network administrator.

• Input the NIC FAX host name or IP address on
the other device. (Pages 26, 56)

• Function settings are being performed on the
operation panel of the connected NIC FAX or
the Administrator Mode of another IC FAX
Monitor is currently in use. Wait until the conflict-
ing procedure is finished and try again.

• The command you are trying to use is already in
being used by a NIC FAX process and cannot
be executed.

• Restart IC FAX Monitor, enter the Administrator
Mode, and change the value. (Pages 116, 121)

• A network error occurred while getting NIC FAX
journal data. Check the following points, recon-
nect, and try again.

• Confirm that NIC FAX is turned on.
• Confirm that the LAN cable is correctly con-

nected to NIC FAX. (Page 24)
• Check whether NIC FAX network settings have

been changed. (Page 56)

[Network error]
Connection error.

[Application Error]
Please enter the name
of the host to connect to.

[FAX command error]
Sorry, busy for doing
some other tasks.

[FAX command error]
Do not have access
permission to change
that value.

[Application Error]

Stopped due to an
error when retrieving
the journal.

           Message Causes and Recommended Actions
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• A network error occurred. Check the following
points, reconnect, and try again.

• Confirm that NIC FAX is turned on.
• Confirm that the LAN cable is correctly con-

nected to NIC FAX. (Page 24)
• Check whether NIC FAX network settings have

been changed. (Page 56)

• A network error occurred. Check the following
points, reconnect, and try again.

• Confirm that NIC FAX is turned on.
• Confirm that the LAN cable is correctly con-

nected to NIC FAX. (Page 24)
• Check whether NIC FAX network settings have

been changed. (Page 56)

• The dial you specified is already used.
Specify a different dial.

• The specified user is already used.

• The specified user is already used.

• Input specified user data.

• Input alphabetic characters, symbols, or spaces
for specified users.

• The number you are trying to add is already
used. Specify a number that is not used.

[Network error]
Exited due to reception
error.

[Network error]
Exited due to transmis-
sion error.

Cannot add item
because this dialling
information already
exists.

Cannot store item
because this dialling
information already
exists.

Cannot add item
because this Specified
Sender address
information already
exists.

You have not entered
any Specified Senders.

Error in entered
Specified Sender data.

Data entry error
(number setting is
duplicated).

           Message Causes and Recommended Actions
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• Input the correct end receiver number when
programming multi-step transfer groups. When
the end receiver is a Quick  or Group Dial, input
a non-zero two-digit number for the end receiver
number.

• Input the correct Personal Code when program-
ming Personal Codes. Input a non-zero four-
digit number for the Personal Code.

• For fax numbers, you can input numbers (0 to
9), pound signs (#), asterisks (* ), and hyphens
(–). For mail addresses, you can input alpha-
betic characters.

• For dial options, you can input numbers (0 to 9),
pound signs (#), and asterisks (* ).

• Input alphabetic characters.

• Input numbers (0 to 9) only.

• The Speed Dial code you specified is outside
the display range. Change the code so it is
within the display range.

• Input the required items.

• An unexpected error has occurred on the
connected NIC FAX. Try executing the com-
mand again.

• Check whether the networking is enabled.
• Check whether your configuration supports

Windows sockets.

Data entry error
(invalid number
setting).

Data input error.
Invalid character in
address.

Data input error.
Invalid character in
dialling options.

Data input error.
Invalid search letter.
Data input error.

Please enter digits
only.

Data input error.
Speed Dial code out
of range.

Please enter all
items required.

[FAX command
error]
An unexpected error
occurred.

Windows sockets
initialization failed.

           Message Causes and Recommended Actions
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IC FAX Com Redirector Messages

           Message Causes and Recommended Actions

• Four-digit numbers in the range of 0001 to 9999
can be specified as Personal Codes. This
message appears when a Personal Code is
specified using fewer than four numbers. Make
sure that your specification does not include any
alphabetic characters or symbols. (Page 111)

• Confirm that the NIC FAX host name or IP
address is set correctly. (Pages 26, 56)

• Confirm that NIC FAX is turned on.
• Confirm that the LAN cable is correctly con-

nected to NIC FAX. (Page 24)
• Confirm that the DNS (Domain Name Server) is

set correctly.
• Two computers are connected to NIC FAX at the

same time. Try connecting again after communi-
cation with the other computer is finished.

• Check NIC FAX access control and access
mask settings. (Page 58)

• Contact your network administrator.

• Confirm that the [System] directory created
when Windows is installed contains a file
named: ricommrg.dll. If this file is not present,
delete the existing IC FAX Port and reinstall IC
FAX Port. (Page 50)

• ricommrg.dll is corrupted. Delete the existing IC
FAX Port and reinstall IC FAX Port. (Page 50)

• Click: [Start], [Settings], [Control Panel],
[Network]. Check the [Configuration] tab to
see if TCP/IP is installed. If not, install TCP/IP.

Invalid Personal Code.

Invalid host name/IP
address.

No response from host.
Can not communicate.

Failed to connect.

Make sure the network
resource is available.

Can not find API in
ricommrg.dll.

Can not load
ricommrg.dll.

Can not find API in
icmp.dll.

Can not load icmp.dll.
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• Click: [Start]→[Settings]→[Control Panel]
→[System]. Check [Ports (COM & LPT)] on the
[Device Manager] tab to see if IC FAX Port is
installed. If not, install IC FAX Port. (Page 30)

• Confirm that the [System] directory created
when Windows is installed contains a file
named: ricomm.vxd. If this file is not present,
delete the existing IC FAX Port and reinstall IC
FAX Port. (Page 50)

• Check if IC FAX Port is being used by another
application. If so, start up IC FAX Com
Redirector after closing IC FAX Com Redirector.
(Page 157)

IC FAX Port is not
installed properly.

IC FAX Port is not
working.

Can not open
ricomm.vxd.

Can not open IC FAX
Port.

           Message Causes and Recommended Actions
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Cannot send from • Check if IC FAX Com Redirector is running. An
icon a fax application. should be on the Task Bar
when it is. (Page 157)

• Check if the IC FAX Com Redirector icon that
communication cannot be performed (page
157). If it does, double-click the icon displays the
setup screen, and make the required settings.

• Click: [Start], [Settings], [Control Panel], [Mo-
dem]. Check the modem properties to see if
Facsimile Modem Type A03 is installed.

• Check if Facsimile Modem Type A03 is con-
nected to IC FAX Port.

• Check if the modem or port settings used by the
fax application are correct.

• The Facsimile Modem Type A03 supports Class
2 AT commands. Specify Class 2 as the com-
mands used by the fax application.

• NIC FAX supports simultaneous connection with
two computers. IC FAX Port cannot be used
when two other computers are connected to
NIC FAX.

• Check if NIC FAX access restrictions are re-
stricted connection. See page 58 for information
on access restriction.

Cannot receive faxes • IC FAX Port is send-only, so it cannot be used to
with IC FAX Port. receive faxes. Turn off the auto receive function

of your fax application.

Cannot install new • When new hardware cannot be installed due to
hardware. resource conflict with IC FAX Port, try deleting

IC FAX Port (page 50) and installing the new
hardware. Then when you reinstall IC FAX Port
the port number assigned to it may change.

Installing IC FAX Port

1. Click:  [Start], [Settings], [Control Panel],
[Hardware].

2. Perform steps 11-2 through 19 from page 36.

3. In step 20 on page 41, click [Yes].

IC FAX Com
Redirector
TROUBLE-
SHOOTING

          Problem Causes and Recommended Actions
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INCLUDED
ITEMS

Item Quantity

CD-ROM (IC FAX Application, NIC FAX CD-ROM

OPERATOR’S MANUAL)
1

BOOKLET 1

USER LICENSE AGREEMENT FOR IC FAX

APPLICATION SOFTWARE
1

INSTALLATION MANUAL 1

Operation Panel Label 1
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SPECIFICATIONS Network LAN : Local Area Network (Ethernet/

10base-T)

Transmit Function Mail

Scan Line Density 200 × 100 dpi,  200 × 200 dpi

Document Size A4

Transmit Protocols Mail send : SMTP (IETF RFC821 and

RFC822),  TCP/IP

Mail receive: POP3 (IETF RFC1725 and

RFC1939), TCP/IP

Mail Format Single/Multi-part  MIME (RFC1521)

conversion

Attached file forms: TIFF-F (MH com-

pression)/DCX

Convertible model NIC FAX

Internet Communication Send and receive Mail with computer

that has an

Mail address

Mail Send Functions Automatic conversion of send document

to Mail format and transmission of Mail.

Memory transmission only.

Mail Receive Functions Automatic detection and printing of

appended TIFF-F (MH)/DCX files and

ASCII text. Memory reception only.
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FUNCTION LIST The list below shows the functions described in this manual only. For

other functions, see FUNCTION LIST which follows index of the main

Operator’s Manual.

• Page numbers marked with an asterisk (*) are main Operator’s

Manual pages.

Description

Use to cancel a PC FAX
transmission

If you program a destination in a Quick
Dial, you can dial that destination by
just pressing that Quick Dial key.

If you program a destination in a
Speed Dial, you can dial that destina-
tion by just pressing the Speed Dial/
Tel. Directory key then entering a 2 -
digit code.

If you program multiple destinations
in a Group, you can specify all those
addresses easily.

Print the Journal manually. Use to
check the results of the last 50
transmissions/receptions.

This is required by the TCP/IP proto-
col, and is a kind of identification
code. Enter the IP address allotted to
you by your system administrator.

Enter the mask that represents the
portion of the network address that is
devoted to subnet addresses.

Enter the IP address of the router
connected to another network.

Page

P.99

P.100
*P.293

*P.296

*P.300

P.90
*P.171

P.26

P.26

P.26

No. Function Name

25 Erasing PC FAX
Transmission

31 Program Quick
Dials

32 Program Speed
Dials

33 Program Group
Dials

41 Printing Journal

61 IP Address

Subnet Mask

Default Gateway
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63 User Parameters

71 Programming the
Personal Codes
(Routing Ad-
dresses)

You can customize various function
settings to suit your requirements.

You can program a Personal Code for
each user. If you enter your Personal
Code when transmitting, you can
check on usage for each Personal
Code.

P.109

*P.223

P.111

*P.75
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• Page numbers marked with an asterisk ( *  ) are main Operator’s Manual pages.

10BASE-T cable

Twisted pair Ethernet cable that provides 10Mbps communication. See page 24.

CSI

Called Station Identification. Data exchanged between machines to let them know who they are communicating with. See

page 18, 19, 150.

IP address

Internet Protocol address used for TCP/IP protocols. A kind of computer ID number.

See page 26, 58.

LAN

Local Area Network. High-speed network of computers, printers, servers, and other devices within a limited area. See

page 24.

MIME

Multipurpose Internet Mail Extensions. Defines a mail protocol for sending non-text data.

See page 12.

POP server

Mail receive server. See page 56.

RTI

Receive Terminal Identification. Identifies the sender. See page 18, 19, 150.

STMP server

Internet-connected e-mail server that routes mail. See page 56.

TIFF-F/DCX

Image formats used when faxes are converted to images. See page 22, 60.

confidential transmission

Transmission that, when received, remains in memory until the proper ID code is input.

See page 131.
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default gateway

IP address of a router in another network to which your network is connected. See page 26.

domain name

Name of a network on the internet. See page 56.

polling reception

Use Polling Receive when you wish to poll a message from another terminal. See page 8, *135.

polling transmission

Use Polling Transmission when you wish to leave a document in the memory for others to pick up. See page 7, *131.

subnet mask

Mask value that allows use of part of an IP address as a network address. See page 26, 58.
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INDEX
1

10BASE-T cable 24, 184

A
Access Control 59

Access Mask 59

Adding a New Group Dial 136

Adding a New Quick Dial 133

Adding a New Speed Dial 133

ADDING FORWARDING STATION ADDRESSES 145

ADDING MULTI-STEP TRANSFER GROUPS 139

ADDING PERSONAL CODES 142

ADDRESS BOOK 129

Admin. Mail Address 61

Administrator Mode 54, 122

APPENDIX 179

B
BACKING UP AND RESTORING MEMORY DATA 63

Backup Mail Address 61

BASIC TRANSMISSION 13

Before Starting Installation 29

BROADCASTING 75

C
Changing from the User Mode to the

Administrator Mode 122

CHANGING THE CONNECTION MODE 122

Class 2 AT commands 95

Confidential Transmission 131, 184

Computer 29

CONNECTING TO A LAN 24

Connecting the LAN Cable 24

Convertible model 181

CPU 29

CSI 18, 19, 150, 184

Confirm New Password 62

Current connection mode 120

Current Password 62

D
DCX 22, 184

Default gateway 26, 184

Deleting a Personal Code 115

Dialling with the Dial Option Key 131

Display 29

DNS 173, 176

Document Size 181

Domain Name 56, 185

E
EDITING FORWARDING SETTINGS 148

EDITING A PERSONAL CODE 114

Editing Quick Dial Data 105

End receiver 77

Entering the Administrator Mode 54

Erasing a Quick Dial 107

ERASING PC FAX TRANSMISSION 99

Error Mail Notification 88

ERROR MESSAGES 166

Error Report (Mail) 88

Error status message 120

F
Facsimile Modem Type A03 40, 45

Fax Application 16

Fax machine memory status 120

Forwarding of a Received Document to a Computer 19

Forwarding of Received Faxes 86

Free Disk Space 29

Function Not Supported by Mail Transmission 7

Function Not Supported by Mail Reception 8

FUNCTION LIST 184

FUNCTION 25 99

FUNCTION 31 100

FUNCTION 63 109

FUNCTION 71 111

G
Gateway 58

GETTING READY 23

Greenwich Mean Time Difference 61
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Host Name 56

Hub 24

I
IBM PC/AT or compatible 29

IC Fax Application 20

IC FAX Com Redirector 21, 157

IC FAX Com Redirector Messages 176

IC FAX Monitor 20, 116

IC FAX Monitor INITIAL SCREEN 120

IC FAX Monitor Initial Screen Messages 168

IC FAX Monitor SETTINGS 54

IC FAX Port 36

ICViewer 22

Image Format 61

INCLUDED ITEMS 180

INITIAL SETTINGS 26

INSTALLATION 29

Installing the IC FAX Applications 30

INTERNET FAX 12

Internet Communication 181

Internet Fax Precautions 7

Internet Mail Settings 56

IP address 26, 58, 184

IP address or host name of connected IC FAX 120

J
Journal 90

JOURNALS (TRANSMISSION AND RECEPTION) 128

L
LAN 24, 184

LAN Cable 24

Login Name 56

Login Password 56

M
Mail Address 56

Mail Format 181

Mail Receive Functions 181

Mail RX Interval 58

Mail Send Functions 181

MAIL SERVER SETTINGS 25

Mail Servers That Have Been Confirmed

To Work 25

Making Initial Settings 26

Memory indicator 13

MEMORY STATUS 123

MIME 12, 184

Minimum Memory 29

Multi-step Transfer Example 84

N
Network 29, 181

NETWORK ADMINISTRATOR 25

Network connection status 120

New Password 62

NIC FAX Display Massages 166

O
Operating System 29

OPERATION PANEL 11

Other Settings 60

Own Number (G3) 150

P
PASSWORD 62, 121

PC FAX Application 95

Personal Code 18, 111, 142

Personal Code List 92

Polling Reception 8, 185

Polling Transmission 7, 185

POP Server 56, 184

Ports (COM & LPT) 38

PRECAUTIONS 7

Print Header Information 61

Programmed a New Quick Dial 102

PROGRAMMING PERSONAL CODES

(ROUTING ADDRESSES) 111

PROGRAMMING QUICK DIALS 100

PWD 131

Q
Quick Dial Key Programming 101

Quitting IC FAX Com Redirector 159

Quitting IC FAX Monitor 118
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Receiving Mail 82

Receiving Transfer Request Mail 83

REPORTS AND LISTS 87

Restoring Memory Data 64

Routing of a Received Document to a Computer 18
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RTI 18, 19, 150, 184

S
Scan Line Density 181

Sending a Fax from a Computer 16
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Sending a PC Fax 96

SEP 131
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SETTING THE ADMINISTRATOR MODE PASSWORD 62

SID 131

SIMPLE SCANNING OPERATION 93

SMTP Server 56, 184

SPECIFICATIONS 181

Specifying an End Receiver Station 81

SPECIFYING THE TARGET FAX 119

Speed Dial Address Input 73

STARTING UP AND QUITTING IC FAX

Com Redirector 157

STARTING UP AND QUITTING IC FAX Monitor 117

Starting Up IC FAX Com Redirector 157

Starting up IC FAX Monitor 117

SUB 131

Subnet mask 26, 58, 185

SVGA 29

System Requirements 29

T
TCP/IP Settings 58

TESTING FOR PROPER OPERATION 67

Testing for Proper Operation 67

Testing Operation by Sending a Fax from

a PC Application 69

TIFF-F 22, 184

TRANSFER REQUEST 77

Transfer Request by Fax 81

Transfer request by mail 77

Transfer requester 77

Transfer Result Report 87

Transfer Station 77

TRANSMISSION 71

Transmit Function 181

Transmit Protocols 181

TROUBLESHOOTING 165

TTI 150

U
Uninstalling Facsimile Modem Type A03 53

UNINSTALLING THE IC FAX APPLICATIONS 47

Uninstalling the IC FAX Applications 47

Uninstalling the IC FAX Port 50

USER PARAMETERS 109

USING A PC FAX APPLICATION 95

Using Index Search 152

USING ONLINE HELP 152, 161

Using Quick Dial, or Group Dial for Address Input 73

V
Version Information 155, 160

Viewing Auto Documents 127

VIEWING FAX INFORMATION 150

Viewing Files Awaiting Transmission 124

Viewing Files That Have Bee Received Into Fax

Memory 126

Viewing the Send and Reception Journals 128

W
WHAT IS AN INTERNET FAX 12



HELP

■ To return to previous pages or views, do any of

the following:

● Right click, then choose [Go Back].

● From the [View] menu, choose [Go Back].

● Click  on the toolbar.

■ To advance through views, do one of the following:

● From the [View] menu, choose [Go Forward].

● Click  on the toolbar.

■ There are several ways to step through the docu-

ment page by page:

● Click  on the toolbar to view the previous

page.

● Click  on the toolbar to view the next page.

● From the [View] menu, choose [Previous Page]

or [Next Page].

● Click on the scrollbar.

■ To view a specific page by number, either:

● Click  on the toolbar, or choose [Thumbnails

and Page] from the [View] menu to display

thumbnail images of each page. Then click the

thumbnail of the page you wish to view.

● Click  on the status bar at the

bottom of the screen. The [Goto Page] dialog will

appear and you can select a page.

?

■ To zoom in on the page, either:

● Click  on the toolbar, or choose [Zoom In]

from the [Tools] menu. Then click over the area

you wish to zoom into.

■ To zoom out of the page, either:

● Click  on the toolbar. Then while holding down

the control key, click on the page to zoom out.

● From the [Tools] menu, choose [Zoom Out] then

click on the page.

■ You can change the way the page is displayed in

the following ways:

● Click  on the toolbar to show the page at its

actual size.

● Click  on the toolbar to show the whole page.

● Click  on the toolbar to show the whole page

width.

● Alternatively, you can choose [Actual Size], [Fit

Page] or [Fit Width] from the [View] menu.

■ For more detailed information, please refer to the

Acrobat online documentation.

From the [Help] menu, choose [Acrobat Online

Guide] to open the Acrobat help file.

This document explains how to view the online operator’s manual.
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INTRODUCTION

INTRODUCTION

Thank you for selecting this product.

This Operator’s Manual explains the procedures and precautions with which you need to be familiar in order to get

the most out of this product. Be sure to read this manual carefully before using the product for the first time, and

keep it on hand for later reference when necessary.

Note that you are authorized to use this Operator’s Manual and the application it describes only after you agree to

the terms and conditions of the User License Agreement that comes with the CD-ROM.

The contents of this Operator’s Manual assume that you are already familiar with Windows functions

and procedures. If you are not, see the documentation that comes with Windows for details on how to

use it.

Important

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any

means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission.

Parts of this manual are subject to change without prior notice.

In no event will the company be liable for direct, indirect, special, incidental, or consequential damages as a result

of handling or operating the machine (hard ware and / or software) and the operator’s manual.

Trademarks

Microsoft®, Windows®, and MS-DOS® are registered trademarks of Microsoft Corporation in the United States and/

or other countries.

All brand names and product names mentioned in this manual are trademarks or registered trademarks of their

respective companies.

Other product names used herein are for identification purpose only and may be trademarks of their respective

companies. We disclaim any and all rights in those marks.
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Other Button Meanings
A list of all the other buttons that appear within the text of this Operator's Manual is shown below.

Click on a chapter title in the contents to jump directly to
the corresponding page.

?

Click to jump to the referenced page.

Click for help on using this User’s Guide.

This button indicates that the current section continues on the next page.
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ICViewer FEARTURES

?
Getting Around This User’s Guide

ICViewer
FEATURES

ICViewer is an application that lets you view images sent from NIC

FAX on

your computer screen.

Here are some of the things you can do with ICViewer.

 • View and browse through pages of an image

 • Edit an image using drawing and text tools

 • Insert bitmaps into an image

 • Save and export images

 • Print out images

 • Send fax messages (not available on some systems)

System Requirements

ICViewer requires the following system to run correctly.

Computer : IBM PC/AT or compatible running Windows 95

(English)

CPU :  i486DX-100MHz or higher

Memory : Enough to run Windows 95 (at least 32MB

recommended)

Free Disk Space : 5MB on drive where application is installed

(program, data, help); at least 30MB on system

drive (50MB recommended)

Display : SVGA 640 × 480, 256 colors minimum (800 ×

600, 64,000 colors recommended)

Operating System : Windows 95 (English)

 Note

Note
• Operation cannot be guaranteed

for all system configurations.



EDITING AN IMAGE

SAVING AND
EXPORTING IMAGES

PRINTING IMAGES

SENDING FAX
MESSAGES

PROPERTIES

VIEWING IMAGES

STARTING UP AND
QUITTING ICViewer

ICViewer FEATURES

IMPORTING IMAGES

Contents

Index

6

STARTING UP AND QUITTING ICViewer

STARTING UP
AND QUITTING
ICViewer

Starting Up

You can start up ICViewer from the [Start] menu or by double-clicking

the icon of a file with a DCX or TIF extension.

Starting Up from the [Start] Menu

1. Point to [Start], [Programs], and then [IC FAX Application].

Next, click [ICViewer].

• This displays the initial ICViewer screen.

2. On the [File] menu, click [Open] and open the file you want.

Starting Up by Double-clicking an Icon

1. Use Explorer or some other means to find the icon of the

DCX or TIF file you want to open.

2. Double-click the icon.

• This starts up ICViewer and displays the contents of the file

whose icon you clicked.

• Files that can be opened with ICViewer are indicated by the

icon .

Quitting ICViewer

On the ICViewer [File] Menu, click [Exit].

?
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STARTING UP AND QUITTING ICViewer

ICViewer Initial Screen

   

1 Menu Bar : Contains pull-down menus of various com-

mands.

2 Tool Bar : Provides one-touch access to functions and

commands.

Tool Bar

          →p.9 →p.12 →p.10 →p.13 → p.9

3 Drawing Tool Bar : A collection of tools for drawing, cutting,

copying, pasting, etc.

Drawing Tool Bar

→p.13 →p.14 →p.15 →p.16 →p.17

1
2
3

4

5

6
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STARTING UP AND QUITTING ICViewer

4 Page Jump Bar : Shows thumbnails of all pages in the docu-

ment. Double-click on a page’s thumbnail to

jump to it. See page 10.

5 Gridlines : Guidelines that help you align objects on the

page. See page 18.

6 Status Bar : Shows the currently selected menu and tool

bar name, zoom factor, paper size, page

number, and CAPS, NUM, and SCRL lock

status.
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VIEWING IMAGES

The button bar, near the top of the screen, has several useful tools for

viewing different parts of an image and moving around a document.

You can also access some of these features from the menu bar.

Drag Scroll

When you move the mouse pointer over the image, the mouse

pointer will turn into a hand. To scroll the image, hold down the

left mouse button and drag the mouse.

Jump to the first page of the document

Move back to previous page

Go to next page

Jump to the last page of the document

Zoom In

Zoom Out

You can also select different magnifications from the Zoom

pulldown menu.

Rotate all pages of the document 90° clockwise

Rotate all pages of the document 90° counter-clockwise

Reverse the page order of a multi-paged document

This is useful for viewing a document that was sent bottom

page first.

Page Width

Chooses a magnification that allows you to view the entire

width of the image on your screen.

VIEWING
IMAGES
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VIEWING IMAGES

Page Jump Bar

The Page Jump Bar shows thumbnails of

all the pages contained in the document,

with the current page indicated by a red

border.

To show/hide the Page Jump Bar:

Click on the button.

To move to a different page:

Double click on another thumbnail image.

To access the Page Jump context menu:

1. Move the mouse to one of the thumbnails in the Page Jump

Bar.

2. Right click and select the function you want.
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EDITING AN IMAGES

This viewer provides tools for editing the image as well as adding text

and drawings. When you have completed editing the image, you can

save it or transfer it to another application.

There are two main types of tools:

 • Image editing tools that act upon the basic image (p.12)

 • Drawing tools for superimposing lines, shapes and text over the

basic image (p.13)

 Note

EDITING AN
IMAGE

Note
• When you choose image editing

tools, all drawing objects will

temporarily vanish.  Do not

worry, they will reappear as soon

as you switch to a different type

of tool.

When you save an image, any

drawing objects you have laid

over the top are combined into

the basic image. This process is

not reversible and the drawing

objects will no longer be

editable.

See “Saving and exporting

images” on page 23 for details

on saving images

......................... See to p.23  

The following features are also available:

 • Gridlines (p.18)

 • Scale to gray view and black and white view (p.18)

 • Object properties (p.19)

 • Layering drawing objects (p.20)

 • Manipulating images (p.21)
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EDITING AN IMAGES

Image Editing Tools

Erase

Deletes parts of the basic image pixel by pixel.

Holding down the right mouse button and moving the cursor

erases everything the cursor passes.

To change the size of the eraser:

Right click over the image and select a different size.

Selection rectangle

Selects an area of the image. Once selected, you can cut (  ),

copy (  ) and paste (  ) the selection.

To select an area of the image:

1. Hold down the left mouse button and drag the mouse to

scale the selection rectangle.

2. Release the button to select the area.

To move part of the image to another position:

1. Move the mouse button over the selected area and hold

down the left mouse button.

2. Drag the mouse.

To copy part of the image to another position:

1. While holding down the [Ctrl]  key, choose the image selec-

tion tool and select the area you wish to copy.

2. Move the mouse pointer over the area, hold down the left

mouse button and drag the copy to where you want it.
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EDITING AN IMAGES

Cut

Cuts currently selected drawing object(s) to the clipboard.

Copy

Copies the selected area to the clipboard.

Paste

Pastes the contents of the clipboard over the image.

Drawing Tools

Toggle Draw Tool Bar

Use to hide or show the draw toolbar.

Cut

Cuts currently selected drawing object(s) to the clipboard.

Copy

Copies currently selected drawing object(s) to the clipboard.

Paste

Pastes the contents of the clipboard over the image.

Select drawing object

Click once on the object you want to select.

To select multiple objects

Either of the two following methods can be used to select multi-

ple objects:

• Hold down the [Shift]  key and click once on each object.

• Hold down the left mouse button and draw a box around the

area containing the objects you wish to select.
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EDITING AN IMAGES

To move an object:

1. Move the mouse over the selected object and hold down the

left mouse button.

2. Drag the object to its new position.

To re-size an object:

1. Select an object. If it is re-sizable, anchor points will appear.

    

2. Hold down the left mouse button on an anchor point and

drag the anchor to scale the object.

Straight line

To draw a line:

1. Press and hold down the left mouse button where you want

the line to begin.

2. Drag the mouse.

Orthogonal line

This is like the straight line tool except the line snaps automati-

cally to the closest vertical, horizontal or diagonal.

Rectangle

To draw a rectangle:

1. Hold down the left mouse button.

2. Drag the mouse to scale the object.

 

Anchor point
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EDITING AN IMAGES

Round-cornered rectangle

To draw a round-cornered rectangle:

1. Hold down the left mouse button.

2. Drag the mouse to scale the object.

When you draw a round-cornered rectangle, an extra anchor

point appears inside the rectangle. Drag on this anchor to alter

the roundness.

    

Ellipse

To draw an ellipse:

1. Hold down the left mouse button.

2. Drag the mouse to scale the object.

Polygon

To draw a polygon:

1. Move the mouse pointer to where you want the first corner

and click once.

2. Move the mouse pointer to another position and click again to

set the next corner.

3. Repeat the previous step for all corners.

4. Double click to fix the object.

Freehand line

Hold down the left mouse button and drag the mouse.

 

Anchor point
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EDITING AN IMAGES

Text box

To place some text:

1. Hold down the left mouse button and drag to make rectangle

for your text to go in.

2. Release the button and type in your text at the keyboard.

To change the font size, family, alignment or style:

1. Switch to the [Select tool] button and click on the text object

once to select it.

2. From the [Object] menu, choose [Properties] (or right-click

on the object and choose [Properties] ).

3. Make any changes and then click on [OK] .
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EDITING AN IMAGES

Stamp

Pastes a preset label onto the image (e.g. “Urgent”).

To place a stamp mark:

1. Click on the [Stamp] button.

2. Choose an image and click on [OK] .

Stamps are grouped as one of four types: [Messages],

[Faces] , [Arrows] , and [English] .

3. Resize and position the image.

 Note

Note
• Selecting a stamp and clicking

[Delete] deletes the selected

stamp.

• You can also add your own

original image as a stamp. See

page 29 for details.

......................... See to p.29 

External Illustration

Click on this button to insert an image file. See page 22 for

details.
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EDITING AN IMAGES

Gridlines

You can superimpose a grid over the current image to help you align

images and drawing objects accurately.

To show the grid:

From the [View] pull down menu, choose [Grid].

To change the grid size (three levels) or hide it:

Choose [Grid] from the [View] menu again and again until the

grid setting is how you wish.

Scale to Gray View and Black and White View

In the Scale to Gray view, the image is displayed using shades of

gray. In the Black and White view, the image is represented as dis-

crete black and white dots. Note that the Scale to Gray view is avail-

able only when the image zoom factor is 100% or less.

To switch between Scale to Gray and Black and White:

From the [View] pull down menu, choose [Scale to Gray] or

[Black and White] .

Zoom Factor

The zoom factor determines the size of the displayed image. 100% is

normal size, while anything below 100% is smaller and anything

greater than 100% is larger. You can set select a zoom factor in the

range of 10% to 300%.

To change the zoom factor

• On the [Zoom] menu point to the zoom factor you want to

select 25, 50, 75, 100, 200, 300, Page Width, Whole Page,

or Custom.

• Instead of using the [Zoom] menu, you could click to

zoom in (enlarge), to zoom out (reduce), or to fit to

the screen width.



EDITING AN IMAGE

SAVING AND
EXPORTING IMAGES

PRINTING IMAGES

SENDING FAX
MESSAGES

PROPERTIES

VIEWING IMAGES

STARTING UP AND
QUITTING ICViewer

ICViewer FEATURES

IMPORTING IMAGES

Contents

Index

19

EDITING AN IMAGES

Object Properties

You can change various properties of a drawing object such as the fill

style and line width.

To change the properties of an object:

1. Select the object.

2. Either right click over the object and choose [Properties], or

choose [Properties] from the [Object] pulldown menu.

3. Make any changes and choose [OK] .

 • Line width : Set a value from 0 to 100.

 • None (Blank shape only) : Specifies whether the area

inside lines should be filled in

(unchecked) or left blank

(checked).

 • Marker : Specifies whether the back-

ground should be transparent

(checked) or opaque (un-

checked).
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EDITING AN IMAGES

Layering Drawing Objects

The Object pulldown menu provides functions that allow you to choose

whether drawing objects appear above or underneath other objects.

Example

STAR above STAR underneath

To move an object up or down a layer:

1. Select the object.

2. From the [Object] pulldown menu,  choose one of the follow-

ing: [Bring Front], [Bring Back], [Bring Top], or [Bring

Bottom].

Fixing an Image

Drawing objects you draw with the drawing tools are different from the

image you are editing. You can select drawing objects individually and

move them around the display, but the main image is a single inte-

grated unit whose elements cannot be selected independently.

You can incorporate the drawing object you are working with into the

main image by executing the Draw menu’s [Fixing an Image] com-

mand. Note that the appearance of the object changes when it is

incorporated into the main image.

Example

Before fixing After fixing

Note that once a drawing object is incorporated into an image, it

cannot be removed.

With some display drivers, attempting to incorporate a colored object

into an image can cause an error.
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EDITING AN IMAGES

Manipulating Images

The Image pulldown menu has functions that allow you to manipulate

all or part of the image.

Note that for these functions to enabled for all objects, you must first

click the [Draw] menu’s [Fixing an Image] command.

The following functions are available:

 •  Fill Rectangle

Fills the inside or outside of an area selected with the selection tool

with white or black.

 •  Invert Image

Inverts the inside or outside of an area selected with the selection

tool. When nothing is selected, this function affects the current

page or all pages.

 •  Denoise

Removes noise from the current page or all pages. This function is

disabled while something is selected with the selection tool.

 •  Emphasis

Emphasizes the current page or all pages. This function is disabled

while something is selected with the selection tool.

 •  Deskew

Deskews the current page or all pages. This function is disabled

while something is selected with the selection tool.
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IMPORTING IMAGES
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You can import images in the following graphics formats:

 • DIB bitmap (.bmp, .dib)

 • Windows Metafile (.wmf)

 • JPEG-JFIF (.jpg)

 • CompuServe GIF (.gif)

 • TIFF (.tif)

 • DCX (.dcx)

To insert a graphics file:

1. Choose [External Illust] from the [Draw] menu.

2. Select the filename and click [OK].

The bitmap will appear selected and you can move and scale it.

To insert an image from the clipboard:

1. From an external application (for example, Paint), select the

graphic you want and copy it to the clipboard.

2. Switch to ICViewer and select [Paste] from the [Edit] menu.

You can now move and scale the image.

IMPORTING
IMAGES
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SAVING AND EXPORTING IMAGES
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You can save multiple pages and export an image file in various

formats.

If you save or export an image, all drawing objects that you have laid

over the image are automatically merged with the original image.

When this happens, it is no longer possible to edit these drawing

objects.

To save all pages to disk:

1. On the [File] menu, click [Save As].

2. Enter a filename and choose a format.

3. Choose [OK].

To save the file under its existing name, click the [File] menu’s

[Save] command or click the  button.

Supported multi-page formats are:

 • DCX

 • TIFF MH Compression

 • TIFF MR Compression

 • TIFF MMR Compression

Files sent by NIC FAX with Mail are saved using DCX or

TIFE-MH compressed format.

To export the current page image to disk as a bitmap:

1. Choose [Export] from the [File] menu.

2. Select a graphics format and click [OK].

Supported single page formats are:

 • Bitmap (.bmp)

 • CompuServe GIF (.gif)

3. Enter a filename and click [OK].

SAVING AND
EXPORTING
IMAGES
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PRINTING IMAGES
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To check how the image will appear on the page before you print:

1. From the [File] menu, choose [Print Preview].

[Next page] : Displays the next page.

[Prev page] : Displays the previous page.

[Two Pages] : Displays two pages at a time.

[One Page] : Displays one page at a time.

[Zoom In] : Enlarges the image.

[Zoom Out] : Reduces the image.

[Close] : Returns to the viewer window.

2. If the image looks OK, choose the [Print]  button.

To print the image directly:

1. From the [File]  menu, choose [Print] .

2. Check your printer settings, then choose [OK] .

PRINTING
IMAGES
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SENDING FAX IMAGES (NOT AVAILABLE ON SOME SYSTEMS)

?
Getting Around This User’s Guide

You can send new images by E-mail. On some systems, you can

send images to a fax machine. Ask your system administrator for

more details.

To send a fax message from the viewer:

You can use Microsoft Exchange to send images you create as

E-mail.

1. If ICViewer is not already started, click on the ICViewer icon

to launch it.

2. Prepare your fax image.

3. From the [File] menu, choose [Send].. then [Send] .

4. Any drawing objects will be merged with the basic fax image

and color will be lost. Click [OK] .

5. A new message window will open with the fax image inserted

in the body of the message as an attachment.

6. To select a destination, click on the [To] button. The Address

Book will open.

7. The addresses available to you are shown on the left. Select

the address you wish to send to and choose [Add]. The

address will be copied to the [recipient list] on the right.

You can send copies to more than one destination by adding

more addresses.

8. Choose [OK] . The [Address Book] will close.

9. Fill in the [subject field] . If you are sending to a PC ad-

dress, you can add some text to the body of the message

before or after the attachment.

10.To send the message, choose [Send]  from the [File]  menu.

SENDING FAX
MESSAGES
(NOT AVAIL-
ABLE ON SOME
SYSTEMS)
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PROPERTIES

These settings allow you to change various defaults, such as the

method of printing, line and eraser styles, location of the stamp

directory and network settings.

To access the ICViewer properties:

1. From the [File] menu, choose [Properties].

2. Click on a tab to view the settings.

3. Choose [OK] to finish.

The following tabs are available in the properties dialog:

 • Printing Info (p.27)

 • Drawing (p.28)

 • Stamp (p.29)

 • Reply Info (p.29)
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PROPERTIES

Printing Info

These settings affect how images made up of more than one page

are laid out on the paper.

Printing type

1 page/sheet Fit one page on each sheet

n pages/sheet Fit more than one page on each sheet

Page size

Large (2 pages/sheet) Fit 2 pages on each sheet

Small (4 pages/sheet) Fit 4 pages on each sheet
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PROPERTIES

Drawing

Use this tab to change the default drawing settings.

Line and fill

Width Default line width

Line color Default line color

Fill color Default fill color

Marker Colours merge with other objects (like a marking

pen)

Blank shape only Special fill feature

Eraser style

Select a large, medium or small eraser.



EDITING AN IMAGE

SAVING AND
EXPORTING IMAGES

PRINTING IMAGES

SENDING FAX
MESSAGES

PROPERTIES

VIEWING IMAGES

STARTING UP AND
QUITTING ICViewer

ICViewer FEATURES

IMPORTING IMAGES

Contents

Index

29

PROPERTIES

Stamp

You can add your own images to the selection available with the

Stamp feature.

To add a stamp image:

1. Select the [Category] to which you wish to add the image.

Alternatively, enter the name of a new category you wish to

create.

2. Enter a description of the image e.g., [Company Logo].

3. Type the image file name for the stamp into [File Name] or

click [Browse] .

4. Choose [Regist.]  to copy the image to the ICViewer stamp

directory.

Reply Info

This function is not available.
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HELP

■ To return to previous pages or views, do any of

the following:

● Right click, then choose [Go Back].

● From the [View] menu, choose [Go Back].

● Click  on the toolbar.

■ To advance through views, do one of the following:

● From the [View] menu, choose [Go Forward].

● Click  on the toolbar.

■ There are several ways to step through the docu-

ment page by page:

● Click  on the toolbar to view the previous

page.

● Click  on the toolbar to view the next page.

● From the [View] menu, choose [Previous Page]

or [Next Page].

● Click on the scrollbar.

■ To view a specific page by number, either:

● Click  on the toolbar, or choose [Thumbnails

and Page] from the [View] menu to display

thumbnail images of each page. Then click the

thumbnail of the page you wish to view.

● Click  on the status bar at the

bottom of the screen. The [Goto Page] dialog will

appear and you can select a page.

?

■ To zoom in on the page, either:

● Click  on the toolbar, or choose [Zoom In]

from the [Tools] menu. Then click over the area

you wish to zoom into.

■ To zoom out of the page, either:

● Click  on the toolbar. Then while holding down

the control key, click on the page to zoom out.

● From the [Tools] menu, choose [Zoom Out] then

click on the page.

■ You can change the way the page is displayed in

the following ways:

● Click  on the toolbar to show the page at its

actual size.

● Click  on the toolbar to show the whole page.

● Click  on the toolbar to show the whole page

width.

● Alternatively, you can choose [Actual Size], [Fit

Page] or [Fit Width] from the [View] menu.

■ For more detailed information, please refer to the

Acrobat online documentation.

From the [Help] menu, choose [Acrobat Online

Guide] to open the Acrobat help file.

This document explains how to view the online operator’s manual.
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